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Welcome 

 

Organization of this Manual 

 

 

Before you use the Binloop, it is suggested that you read this 
instruction manual thoroughly.  The Getting Started section contains 
some simple operational examples and explains how to quickly get up 
and running with the A/V Binloop Uncompressed hardware.  Later 
sections contain more detailed information on programming and 
operation, including how to integrate your Binloop into a control system 
and the various hardware configuration options that you’ll need to set 
up. 

 

 

 

Technical Support 

Should questions or issues come up, which are not covered in this 
User's Manual, please do not hesitate to contact us.  We are here to 
help! 

You can contact us: 

On The Web:   http://www.alcorn.com 

By E-mail:   support@alcorn.com 

By Phone:   (407) 296-5800 (M-F 9-6 EST) 
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Getting Started 

In this section, you will learn how to: 

• Install the Binloop 

• Play a test video 

 

Installation 

These instructions assume that you have received your Binloop from 
Alcorn McBride with the Controller card and the appropriate 
reproducers already installed.  For detailed instructions and 
information on installing the Binloop see the Installation Guidelines 
section later in this manual. 

Unpacking Instructions 

When you unpack this product you may want to consider holding on 
to the original packing material for shipment to the installation site, or 
in case you need to return it to the factory for repair or exchange. 
PLEASE DON’T THROW AWAY THIS MANUAL! 

 

Installation Instructions 

 

 

 

 

 

 

Note: It is always ideal to use 
power protection such as surge 
protection and/or an 
uninterruptible power supply to 
ensure a reliable power source 
for the Binloop. 

The Binloop is designed to be installed in an equipment rack.  It is 
recommended that you leave an empty space (1U) above and below 
the unit for free-air circulation, and install it in a climate-controlled 
room.  Failure to do so could result in damage or intermittent 
operation of the Binloop.  

 

1. Place the Binloop in the appropriate position on the rack. 

2. Insert screws into the rack-mounting holes on both sides of 
the unit and tighten. 

3. Connect the power plug to an appropriate outlet. 

4. The Binloop will operate with 100-240VAC, 6-3A Max. 60-50 
Hz. 

5. Connect the video cables from the Reproducer outputs to the 
equipment (i.e. displays etc.) 
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Playing a Test Video 

Now it’s time to put that nice shiny new Binloop to work and make it 
play some video.  This section will guide you through the steps 
necessary to make that happen. 

Preparation 

Before you can play video on the Binloop, you need to load video 
content onto an SSD (Solid State Disk).  To do this, you’ll need the 
following items: 

 

1. SSD 

2. USB to SATA cable or dock 

3. A/V Binloop Uncompressed Test Video 

 

Solid State Disk 

In order for reliable and trouble-free operation, please purchase your 
SSD’s from Alcorn McBride.  The A/V Binloop Uncompressed 
requires extremely high performance that many SSD models cannot 
achieve.  Performance variations exist even between the same model 
of SSD due to internal firmware and die changes by the drive 
manufacturer.  Drives purchased from Alcorn McBride have been 
tested and confirmed to work in the A/V Binloop Uncompressed.  To 
help you select a size that suits your needs, be sure to read over 
Appendix B: SSD Media Capacities. 

 

USB to SATA cable 

Your A/V Binloop Uncompressed came with a USB 3.0 to SATA3 
cable that can be used to transfer data to the drive.  Other options for 
transferring data to the SSD include Thunderbolt SATA docks, or an 
eSATA to SATA cable and power supply.   

 

A/V Binloop Uncompressed Test Video 

The A/V Binloop Uncompressed test video can be downloaded from 
the test media page on our website. Here’s a link: 

http://www.alcorn.com/ftp/media 

http://www.alcorn.com/ftp/media
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Formatting the SSD 

 

 

 

When you insert a flash card, 
do so with the top of the SSD 
to the right.  The SSD should 
insert easily and require very 
little force to fully seat. 

 

Once you have the necessary materials, you are ready to get 
started. First, it is recommended that you format the SSD card in the 
Binloop.  This can be accomplished by following these instructions: 

With the SSD removed, power up the Binloop using the power switch 
on the back of the unit. 

Press and hold the Test Button on Reproducer card.  You may see 
the Reproducer indicate a fault (flashing red LED), but this is normal. 

While holding the Test Button, insert the SSD into the SSD socket.  
Wait for the status LED to turn orange to indicate that the card is 
being formatted (approximately 5 seconds). 

When the status LED turns off, the formatting is complete.  You may 
now remove the card. 

 

Loading the Test Video 

Now that the SSD has been properly formatted, we’re ready to load 
the A/V Binloop Uncompressed Test Video onto the card.  Here’s 
what you do: 

 

1. Connect the SATA side of the USB to SATA cable to the drive. 

2. Connect the USB side of the USB to SATA cable to you PC.  The 
SSD will appear as an additional drive (i.e. Drive F:) in your 
computer. 

3. Copy and Paste the Test Clip directory to the flash card. 

4. Verify that the name of the test clip directory is VID00001. 

5. Using the MediaFlow software, select A/V Binloop Uncompressed 
from the Product List and click the “Index Drives” button in the 
bottom-right of the screen.  Then, choose the drive letter of your 
SSD. 

6. Eject the drive and remove the SSD from the cable. 
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Playing Video 

All of your hard work is about to pay off.  Follow these step-by-step 
instructions to play the test video in the Binloop. 

 

1. If you have not already done so, connect a display to one of 
the A/V outputs of channel #1 (HDMI or 3G-SDI).   

2. Insert the SSD that is loaded with the A/V Binloop 
Uncompressed test clip into the channel #1 SSD socket. 

3. Power-up the Binloop. 

4. Wait for the Binloop to finish initializing.  You can determine 
this by watching status display and the ‘READY’ status LED. 

5. Press the channel #1 test button.  The channel #1 status LED 
should turn green to indicate that the video is playing. 

 

At this point, channel #1 should be outputting video on the rear-panel 
connectors, and this should be apparent on your display.  If it is not, 
please consult the Troubleshooting Guide for help. 
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About the Binloop 

 

What is the Binloop? 

Put simply, the A/V Binloop Uncompressed is a solid-state multi-
channel video player that provides up to 8 separate channels of HD or 
2K video, or up to 2 channels of UltraHD (3840x2160) or 4K 
(4096x2160) resolution. These video channels can be played together 
synchronously or independently from one another.  For stand-alone 
applications, the Binloop can be configured to play files automatically 
based on a programmable timeline.  For more complex applications, 
this product can be controlled externally by SMPTE/EBU timecode, 
MIDI, RS-232, Ethernet or contact closures. 

That being said, the Binloop is not your everyday multi-channel video 
player.  Its ability to provide synchronous playback, impeccable 
precision, and a variety of easy-to-use control interfaces requires 
unique system architecture.  The purpose of this section is to 
familiarize you with how the Binloop works so that you can gain a 
better understanding of how best to use it to meet your goals. 

 

What’s inside the Binloop? 

The Binloop consists of three main types of components –  

1. Card Cage  

2. Controller Card 

3. Reproducer Card(s) 

 

 

 

The Card Cage 

 

 

The Reproducer slots may or 
may not be populated 
depending on how your 
Binloop was ordered. 

The Card Cage is the ‘skeleton’ that integrates the components of the 
Binloop.  This cage contains a Power Supply, a status display, a 
Controller card slot, and 8 Reproducer card slots.  The Reproducer card 
slots are numbered from 1 to 8, from left to right as viewed from the front 
of the Binloop.  

The back of the Card Cage contains all of the connectors for the Binloop 
control interfaces, as well as Video outputs for all 8 Reproducer card 
slots. 
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The Controller Card 

The Controller Card is responsible for the core functionality of the 
Binloop.  This card updates the Status Display with information and 
provides front-panel buttons for controlling basic Binloop functions. It 
also handles all external communication from the remote control 
interfaces of the Binloop, as well as internal communication with the 
Reproducer cards. In addition, it provides the Binloop with the ability 
to either Generate or Read SMPTE timecode. It also has the ability to 
store a list of SMPTE triggers that can be precisely executed at 
specified times. To maintain synchronization between Binloop 
components, this card also supplies all video sync signals to the 
Reproducer cards. 

 

The Reproducer Cards 

The main function of each Reproducer is to play video files from a 
removable SSD drive.  During playback, the video output generated 
by the reproducer is available on the connectors found on the back of 
the Binloop cage.  Each reproducer has output connectors for HDMI 
and 3G-SDI. 

The reproducer cards receive all playback commands (i.e. Play, Stop, 
Pause, etc.) from the controller card.  To ensure perfect 
synchronization, the reproducers share common Video clocks that are 
supplied by the controller card as well. 

The clips themselves are directories containing an image sequence of 
TARGA or AMT files.  For more specific information regarding the 
type of media content that the reproducer cards can play, refer to the 
chapter that covers Media Files. 
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How the Binloop Works 

Now that you’re more familiar with the various hardware components 
that comprise the Binloop, let’s get more familiar with how those 
components actually work together.  The diagram below outlines the 
different components we’ve covered as well as their functional 
relationship with one another. 

 

 

 

The sections that follow will cover the various systems you see in this 
diagram, so please use it as a visual reference. 
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Control System 

The Control system of the controller card is the heart of the Binloop.  
This system handles all of the Binloop’s control interfaces.  In 
addition, the Control system is responsible for configuring and 
controlling both the SMPTE Interface and the A/V Sync system that 
also reside on the controller card.  This system’s final significant role 
is to configure and control the reproducers over a shared 
communications line. 

 

Control Interfaces 

The Control system monitors all of the control interfaces, which 
include Ethernet, Parallel, RS-232, and the Front Panel interface.  
Anything that happens on these interfaces, in one way or another, is 
translated by the Control system into a command to do something.   

For example, the Control system may receive an RS-232 command to 
play video 1 on reproducer 1.  It must interpret this command, and 
then send the appropriate control signal to the reproducer to make it 
happen.  Another common example would be using the Parallel 
control port to start the SMPTE generator.  The Control system would 
sense a contact closure on the Parallel control port, and then instruct 
the SMPTE Interface to start generating timecode. 

You can read more about these control interfaces, and how they work 
in a later chapter in this manual titled Controlling the Binloop. 

 

Reproducer Control 

Without the Control system, the reproducers would do nothing except 
generate black video and waste electricity. They have no knowledge 
of the SMPTE clock value, RS-232 commands, Parallel input status, 
or anything of the sort. They are simply designed to obey basic 
playback commands and, in that regard, the Control system is their 
boss. It is responsible for issuing configuration and playback 
commands to the reproducers, and is capable of doing so with 
tremendous precision.  
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A/V Sync System 

The A/V Sync system plays a critical role in the operations of the 
Binloop. This system is responsible for generating the Video clocks 
used throughout the Binloop. Most notably, these clocks are used 
directly by the reproducers to ensure that the video outputs are 
precisely synchronized with one another.   

 

Configuration Options 

This system has a few straight-forward, yet important, configuration 
settings. The first of these settings, Video Format, configures the type 
of video clocks to generate. This setting will determine the video 
output formats that the reproducers can be configured with.   

 

Setting Options 

Video Format NTSC 29/59, PAL 25/50, FILM 
23/47, FILM 24/48, and NTSC 
30/60 

 

These settings can be configured using the Menu Wheel interface on 
the front of the Binloop, as well as the Binloop Configuration software. 

 

External V-Sync 

 

 

The A/V Sync system always 
generates the A/V clocks 
regardless of whether or not an 
external sync source is 
present. 

If you refer to the diagram earlier in this section, you will see that the 
A/V Sync system allows for an optional external video sync source.  
When a supported sync source is connected to V-Sync input of the 
Binloop, the A/V clocks are locked directly to the source. 

This input is designed to accept a Blackburst video sync signal.  Keep 
in mind that the Video Format setting of the A/V Sync system must 
match the video format of the Blackburst sync source.  If it does not, 
the A/V Sync system will not attempt to lock to the source.  
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SMPTE Interface 

The SMPTE Interface is what gives the Binloop the ability to generate 
and read SMPTE and EBU timecode.  Whether it is generating or 
reading, this interface provides the Control system with the current 
SMPTE time. The most important purpose for this is to execute 
precisely timed user-programmed commands, or triggers, to the 
reproducer cards.  In addition, it provides a SMPTE Frame Clock 
which is used throughout the Binloop for synchronization purposes. 

Configuration Options 

The SMPTE Interface is a very powerful and flexible system and, as a 
result, it has a variety of configurable settings. Here is a summary of 
those settings: 

 

Setting Description 

SMPTE Mode Determines whether the SMPTE Interface will 
generate timecode, or read external timecode. 

Framerate The framerate in which SMPTE is generated. 

Preroll Time The initial time of SMPTE generator when it is 
first enabled. 

Start Time The time that the SMPTE generator returns to 
after it reaches the End Time (when looping) 

End Time The time when the SMPTE generator either 
stops or loops back to the Start Time. 

Loop Mode Determines whether the SMPTE generator 
loops continuously from Start to End Time. 

Powerup Mode Determines whether SMPTE is Enabled or 
Disabled when the Binloop powers up. 

Restart Mode Determines how the SMPTE generator 
responds when it is told to start again.  It can 
either restart or ignore the start command. 

Idle Mode Determines if the SMPTE Output is muted or 
active when the SMPTE Interface is idle. 

Self-Gen Mode Determines how long the SMPTE reader will 
free-wheel when external SMPTE is lost. 

Output Level Configures the voltage level (in dB) of the 
SMPTE output. 

 

These settings can all be configured using the Menu Wheel interface 
on the front of the Binloop, or with through the Binloop software.  
Please read on to learn more about these settings and how they can 
be used to configure the SMPTE Interface to meet your needs. 
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SMPTE Mode 

There are 3 basic modes that the SMPTE Interface can operate in. It 
can be configured to Read timecode, Generate timecode, or generate 
timecode in reference to the Binloop’s video clocks (Generate /w V-
Sync). 

In Read mode, the SMPTE module will listen for incoming timecode 
on the Binloop’s SMPTE In connector whenever the SMPTE module 
is enabled. While operating in this mode, the SMPTE Interface will 
repeat the incoming timecode on the SMPTE Out connector. 

In SMPTE Read mode, the Binloop will attempt to lock its video 
clocks to the incoming SMPTE code. Lock indicator will light up on the 
front panel if the lock is successful. 

In Generate mode, the SMPTE Interface will generate timecode when 
it is enabled (or started). This timecode is used internally, and is also 
generated on the SMPTE Out connector.  

The Generate /W V-Sync mode operates exactly like the normal 
Generate mode, except that the SMPTE clock is generated 
synchronously with the vertical sync video signal of the Binloop.  For 
example, if the Binloop’s A/V Sync system is configured for NTSC 
(29.97fps), the SMPTE module can generate 29.97fps timecode that 
is perfectly synchronous. This means that each ‘tick’ of the SMPTE 
clock will coincide with the beginning of each video frame, even after 
a long period of time.  This feature is useful when you want the 
SMPTE clock to remain in perfect sync with a video presentation, or 
with an external video sync source. 

 

SMPTE Times 

The Preroll, Start, and End times are all used by the SMPTE Interface 
when it is programmed to generate timecode.  This graphic 
demonstrates how these times are used by the generator.  

 

 

 

As you can see, the timecode starts running from the Preroll Time 
when the SMPTE Interface is first enabled. The timecode then 
continues to run until the End Time is reached. What happens at this 
point depends on the next setting; Loop Mode.   
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Loop Mode 

The Loop mode setting determines what the timecode generator does 
when the End Time is encountered. If the SMPTE module is 
configured to loop, the timecode jumps back to the Start Time. If loop 
mode is disabled, the timecode stops running. 

Powerup Mode 

The Powerup setting simply tells the SMPTE Interface whether or not 
to start running when the Binloop first turns on. When the Binloop is 
configured to start on powerup, the SMPTE Interface will begin 
generating/reading timecode as soon as the system is ‘ready’ (this is 
indicated by both the ‘ready’ output and ‘ready’ unit status LED). 

 

Restart Mode 

The Start SMPTE Command 
can come from any of the 
Binloop’s control interfaces, 
including Parallel, RS-232, 
Ethernet, MIDI, or the front-
panel.   

The Restart Mode setting only applies when the SMPTE Interface is 
configured to generate timecode. This setting determines how the 
generation process is affected if a ‘Start SMPTE’ command occurs 
when timecode is currently running. If the Restart Mode is enabled, 
another Start command causes the timecode to jump back to the Start 
Time. If the Restart Mode is disabled, any start commands received 
while the timecode is running will be completely ignored. 

 

Idle Mode 

The Idle Mode determines the state of the SMPTE Output when the 
SMPTE Interface is Stopped. If the Idle Mode is configured to mute 
SMPTE, the SMPTE output will be silent when the SMPTE clock is 
stopped. If the Idle Mode is configured for SMPTE to be active, the 
SMPTE Output will continuously repeat the timecode value where the 
clock stopped running on the SMPTE Output. 

 

Self-Gen Mode 

 

If external SMPTE drops out, 
the SMPTE reader will 
automatically re-lock when it is 
restored.  The Self-Gen Mode 
simply determines what to do 
in the meantime. 

This setting applies only when the SMPTE Interface is configured to 
Read external timecode. It determines how the SMPTE reader should 
react in the event that the external SMPTE signal drops out, or is lost 
completely. When this occurs, the SMPTE reader has the ability to 
continue generating (free-wheel) SMPTE on its own. This allows the 
Binloop to ‘get by’ until the external SMPTE clock is restored. If you 
want to implement this feature, this setting can configure the SMPTE 
Reader to self-generate timecode for a period of 1-8 seconds, or 
indefinitely. If you don’t want to use this feature, Self-Gen mode can be 
disabled completely so that the timecode within the Binloop always 
represents the timecode coming in on the SMPTE Input. 
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Controlling the Binloop 

To ensure that the Binloop can meet the needs of almost any application, 
it has been designed with several different control interfaces. These 
interfaces include: 

1. Serial (RS-232) 

2. Ethernet 

3. Parallel 

4. Timecode 

 

Serial Control (RS-232) 

The Binloop provides a dedicated Show Control RS-232 port to allow 
external RS-232 devices to control the product. For added flexibility, this 
port can be configured to use a variety of serial protocols.  Here’s a table 
that outlines the differences between these protocols: 

 

Protocol Baud Rate Description 

Alcorn 9-bit 9600 For use with legacy Alcorn Show 
Controllers. 

AMI/Pioneer 9600 Generic ASCII-based protocol 
intended for use by almost any 
serial control device, including 
Alcorn Show Controllers. 

Debug 38400 Debug output only.  Not used for 
control. 

 

Once you determine which protocol is best for your system, you must 
configure the Show Control port for one of these 4 protocols.  This can 
be done using the front-panel Menu Wheel, or by downloading a 
configuration from the Binloop software.  When you are ready to control 
the Binloop, you must connect a NULL RS-232 cable between the 
controlling device and the Binloop’s Show Control port.  Once you have 
done this, read on to the Control Protocols section of this manual to 
obtain the full list of commands you can send to the Binloop. 
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Ethernet Control 

For Ethernet control, the Binloop uses a standard Ethernet Protocol 
called UDP (User Datagram Protocol).   

UDP is a very simple Ethernet protocol that allows an Ethernet device to 
transmit a generic string of data to another Ethernet device.  Since UDP 
is such a broad standard, UDP packets can be generated by a large 
variety of controllers and PC applications.  The UDP packet handles all 
of the complexities of getting the message where it needs to go in one 
piece.  The good news is that you do not have to understand those 
complexities.  As a matter of fact, you only need to know the following 
information to send a UDP message.   

 

Destination IP Address – This needs to be the IP address of the 
Binloop you intend to control.  The default IP address of the Binloop is 
192.168.0.254. 

Destination Port – This value needs to be the UDP port that the Binloop 
is listening to for UDP commands.  This value is always 2638. 

Source Port - This is the UDP port that your PC or controller will use to 
send the UDP message.  It does not matter what port you choose, as 
long as it is a valid UDP port.  If you have no idea what a valid UDP port 
is, just use 2638. 

Data – This is the actual message that you are sending to the Binloop.  
This message needs to be an AMI/Pioneer Protocol command. (i.e. 
1R1PL<CR>). 

 

Since the UDP commands use the AMI/Pioneer Protocol, they are ASCII 
based and are terminated with a carriage return (hexadecimal value 
0x0D).  The complete list of supported commands can be found in the 
AMI/Pioneer Protocol section of this manual. 

 

 

Parallel Control 

The Binloop’s Parallel Control interface is designed to provide a very 
basic control from simple voltage and contact closure inputs.  This 
interface also has 3 dry-contact relay outputs and 2 TTL level outputs 
that indicate the status of the Binloop.  All of these signals are available 
on the DB-37 Parallel Control connector located on the back of the 
Binloop. 
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Parallel Inputs 

The following table lists the available inputs of the Binloop’s Parallel 
control interface, as well as description of their functions: 

 

Function Contact 
Closure 

Pins 

Voltage 
Pins 

Description 

*Start  7(+),8(-) Start SMPTE 

*Pause  9(+),10(-) Pause SMPTE at next SMPTE loop 
point 

*Stop  11(+),12(-) Stop SMPTE, Stop all reproducers. 

Play Group #1 20, GND**  Play and Loop clip #1 on Group #1 

Play Group #2 21, GND**  Play and Loop clip #2 on Group #2 

Play Group #3 22, GND**  Play and Loop clip #3 on Group #3 

Play Group #4 23, GND**  Play and Loop clip #4 on Group #4 

Play Group #5 24, GND**  Play and Loop clip #5 on Group #5 

Play Group #6 25, GND**  Play and Loop clip #6 on Group #6 

Play Group #7 26, GND**  Play and Loop clip #7 on Group #7 

Play Group #8 27, GND**  Play and Loop clip #8 on Group #8 

Reset SMPTE 28, GND**  Stop SMPTE 

Idle SMPTE 29, GND**  Pause SMPTE immediately 

Note: Pins not listed here or in the Parallel Outputs table should be 
left unconnected. 

*These functions are identical to the front-panel control buttons of the 
Binloop. 

**GND can be any one of the ground pins on the Binloop’s Parallel 
Control Connector. This includes pins 16, 17, 18, and 19. 

 

 

 

 

 

 

 

 



 

Alcorn McBride A/V Binloop Uncompressed User’s Manual Page 18 

Parallel Outputs 

The following table lists the status outputs that are provided by the 
Parallel control interface of the Binloop: 

 

Function TTL 
Output 

Pins 

Contact 
Closure 

Pins 

Description 

*Running  1,2 CLOSED when SMPTE is running 

*Fault  3,4 CLOSED when Binloop is in Fault state 

*Ready  5,6 CLOSED when Binloop is ready to 
receive commands 

SMPTE Lock 33, GND**  HIGH (5V) when locked on to external 
SMPTE 

VSync Lock 34, GND**  HIGH (5V) when locked on to external 
Video Sync 

Note: Pins not listed here or in the Parallel Inputs table should be 
left unconnected. 

*These relay outputs directly mimic the Run, Fault, and Ready unit 
status LED’s on the front panel of the Binloop. 

**GND can be any one of the ground pins on the Binloop’s Parallel 
Control Connector. This includes pins 16, 17, 18, and 19. 

 

 

Using the Group Control Inputs 

The Binloop has contact-closure inputs on the rear panel that can be 
used to command groups of Reproducers to Play.  When used on their 
own, these 8 ‘Play Group’ inputs cause the associated group to play and 
loop the associate file.  For example, activating the ‘Play Group 2’ input 
will cause all reproducers assigned to group 2 to play and loop file #2.  
Activating ‘Play Group 4’ will cause all members of group 4 to play and 
loop file #4. 
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Using the Start SMPTE Input 

 

 

Please refer to the Hardware 
section of this manual for pin 
assignments and other 
electrical details for the Parallel 
Control connector. 

 

The Parallel Control connector also contains inputs for starting or 
stopping the SMPTE Interface.  Unlike the Group Control inputs, the 
SMPTE Control inputs are Opto-Isolated and require a voltage (24V) to 
be input to them from an external source. 

The way to start playback using the SMPTE Control inputs is to configure 
the Binloop to generate SMPTE, program a playback trigger in the 
SMPTE Trigger Table and start SMPTE using the Start SMPTE input.  
When the timecode reaches the programmed trigger time, playback 
begins. 

Single Reproducers, Groups of Reproducers, or All Reproducers can be 
triggered.  It’s all in how you program the trigger. 

 

 

Timecode Control 

In this method of control, the commands are pre-programmed ahead of 
time using the Binloop software, and then downloaded and stored in the 
Binloop.   

The concept is pretty simple.  When you program the commands, you 
must specify a SMPTE timecode value for that command.  If the SMPTE 
clock ever equals that timecode value, the command (or trigger) is 
executed.  This concept applies whether the SMPTE is being read from 
an external source, or generated internally by the Binloop. 

There are several benefits to using this control interface. First, this 
interface allows the Binloop to operate completely on its own. For 
example, you could program the Binloop to automatically generate 
SMPTE timecode when it powers-up.  You could then create a ‘Play’ 
command that gets triggered by the timecode shortly after it starts 
running.  The result is that the Binloop automatically starts playing after 
power-up with no external control required!   

The other benefit to this interface is precision. Each command’s SMPTE 
execution time is accurate down to the frame. For example, you could 
make a video start playing at exactly 01:02:05.21. Again, it doesn’t 
matter if that timecode is being read from an external source or 
generated internally.  This precision also helps with tweaking the 
playback timing.  Is the video starting a little too soon?  Just add 1 or 2 
frames to the SMPTE execution time to make it start a little later.  

For more information about using this method of control, please refer to 
the Binloop Configuration Software section of this manual.  If you 
would like to configure the Binloop to automatically play upon power up, 
please see the Application Notes section of this manual. 
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Control Protocols 

 

AMI/Pioneer Control Protocol 

For specific information about 
the RS-232 and Ethernet 
interfaces, refer to the 
Controlling the Binloop 
section of this manual. 

 

This protocol inherits its name 
from the fact that it closely 
resembles the popular Pioneer 
protocol used throughout the 
A/V industry. 

The AMI/Pioneer protocol commands listed in this section are available 
for use on both the RS-232 Show Control port and the Ethernet port of 
the Binloop.  This section discusses the most commonly used 
commands in detail. 

 

The protocol is ASCII-based. Upper or lower case characters can be 
used interchangeably.  All commands and responses are terminated 
with the Carriage Return character. This character is represented by 
the hexadecimal value 0x0D. 

 

 

Get Firmware Version 

Description:    This command will return the controller firmware version number. 
 
Command:  ?V 
Response:  DBAP5 Vx.xx 
 
Example:  Command: ?V 
   Response: DBAP5 V1.00 
 

Get Hardware Version  

Description:   This command will return hardware revision and hardware configuration version 
number. 

 
Command:  ?H 
Response:  FPGA Vx.xx PCB Rev X 
 
Example:  Command: ?H 
   Response: FPGA V1.00 PCB Rev B 
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Get SMPTE Firmware Version 

Description:    This command will return the firmware version of the SMPTE module. 
 
Comments:   It is possible for the SMPTE firmware to be corrupted. If this occurs, this 

command will return a hardware error (E01). 
 
Command:  ?S 
Response:  SMPTE Vx.xx 
 
Example:  Command: ?S 
   Response: SMPTE V1.23 

 

Get/Set Unit ID 

Description:    This command will get or set the unit ID number. 
 
Parameters:    xx represents a decimal number between 1 – 49. 
 
Set Command:  xxID 
Response:  R 
 
Example:  Command: 1ID  

Response R 
 
Get Command:  ID 
Response:  xx 
 
Example:  Command: ID  
   Response: 1 
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Add/Remove Group 

Description:    This command will add or remove a reproducer from a group. 
 
Command:   ngggaaaAG 
 
Parameters:    n = Group Membership 
    0 = Remove from Group 
    1 = Add to Group 
   ggg = Group Number (G1-G13) 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
 
Example:  Add Reproducer 3 to Group 10:   1G10R3AG  
   Response:     R 

 

Get/Set IP address 

Description:  This command will get or set the unit IP address. 
 
Parameters:    xxx.xxx.xxx.xxx represents a standard IPv4 IP address. 
 
Get Command:  IP 
Response:  xxx.xxx.xxx.xxx 
 
Example: Command: IP  

Response:  192.168.0.254 
 
Set Command:  xxx.xxx.xxx.xxxIP 
Response:  R 
 
Example:  Command: 192.168.0.254IP  

Response: R 
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Get/Set Subnet Mask number 

Description:    This command will get or set the number used to isolate the subnet. 
 
Parameters:    xxx.xxx.xxx.xxx is a standard IPv4 subnet mask. 
 
Get Command:  SM 
Response:  xxx.xxx.xxx.xxx 
 
Example:  Command: SM  

Response: 255.255.255.0 
 
Set Command:  xxx.xxx.xxx.xxxSM 
Response:  R 
 
Example:  Command: 255.255.255.0SM  

Response: R 
 
 

 

Get/Set Gateway address 

Description:    This command will get or set the IP address of the network gateway. 
 
Parameters:    xxx.xxx.xxx.xxx is a standard IPv4 IP gateway address. 
 
Get Command:  GW 
Response:  xxx.xxx.xxx.xxx 
 
Example:  Command: GW  

Response: 192.168.0.1 
 
Set Command:  xxx.xxx.xxx.xxxGW 
Response:  R 
 
Example:  Command: 192.168.0.1GW  

Response: R 
 
 

Enable SMPTE 

Description:    This command will Enable the SMPTE interface. 
 
Comments:   If the SMPTE module is configured to Generate, this command will cause the 

clock to start generating at the configured Preroll time.  If the SMPTE module is 
configured to Read, it will start listening for SMPTE time code on the SMPTE 
Input.  If the SMPTE clock is in a paused state, this command will cause it to 
resume from its current position. 

 
Command:  ES 
Response:  R 
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Disable SMPTE 

Description:    This command will disable the SMPTE interface. 
 
Comments:   If the SMPTE module is configured to Generate, this command will cause the 

SMPTE clock to stop at its current time.  If the SMPTE module is configured to 
Read, this command will cause the SMPTE clock to stop running and ignore any 
incoming time code. 

 
Command:  DS 
Response:  R 
 

Pause SMPTE 

Description:    This command will pause the SMPTE clock at the next loop point. 
 
Comments:   This command only applies when the SMPTE module is in Generate mode and is 

also configured to loop.  When paused, the SMPTE clock can be resumed by 
sending an Enable SMPTE command. 

 
Command:  PS 
Response:  R 
 

Idle SMPTE 

Description:    This command will pause the SMPTE clock immediately. 
 
Comments: When paused, the SMPTE clock can be resumed by sending an Enable SMPTE 

command. 
 
Command:  IS 
Response:  R 
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Get/Set SMPTE time 

Description:    This command will get or set the current SMPTE time. 
 
Parameters:    hh  = hours 
   mm  = minutes 
   ss = seconds 
   ff = frames 
 
Get Command:  CT 
Response:  hh:mm:ss.ff 
 
Example:  Command: CT  

Response: 01:59:59.30 
 
Set Command:  hh:mm:ss.ffCT 
Response:  R 
 
Example:  Command: 01:59:59.30CT  

Response: R 
 
 
 
 

Get/Set SMPTE Mode 

Description:   This command will get or set the operating mode of the SMPTE module. 
 
Parameters:    x = mode number: 
    0 = read 
    1 = generate 
    2 = generate with V-sync 
 
Get Command:  SO 
Response:  x 
 
Example:  Command: SO  

Response: 2 
 
Set Command:  xSO 
Response:  R 
 
Example:  Command: 2SO  

Response: R 
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Get/Set SMPTE Frame Rate Mode 

Description:    This command will get or set the SMPTE frame rate. 
 
Parameters:    x = mode number: 
    0 = 23.976 fps 
    1 = 24 fps 
    2 = 25 fps 
    3 = 29.97 fps 
    4 = 30d fps 
    5 = 30 fps  
 
Get Command:  FR 
Response:  x 
 
Example:  Command: FR  

Response: 5 
 
Set Command:  xFR 
Response:  R 
 
Example:  Command: 5FR  

Response: R 
 
 

Get/Set SMPTE Preroll time 

Description:    This command will get or set the SMPTE preroll time. 
 
Parameters:    hh = hours 
   mm = minutes 
   ss = seconds 
   ff = frames 
 
Get Command:  PT 
Response:  hh:mm:ss.ff 
 
Example:  Command:  PT  

Response:  00:01:30.10 
 
Set Command:  hh:mm:ss.ffPT 
Response:  R 
 
Example:  Command:  00:01:30.10PT  

Response:  R 
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Get/Set SMPTE Start time 

Description:    This command will get or set the SMPTE start time. 
 
Parameters:    hh = hours 
   mm = minutes 
   ss = seconds 
   ff = frames 
 
Get Command:  RT 
Response:  hh:mm:ss.ff 
 
Example:  Command: RT  

Response: 00:00:01.00 
 
 
Set Command:  hh:mm:ss.ffRT 
Response:  R 
 
Example:  Command: 00:00:01.00RT  

Response: R 

 

 

Get/Set SMPTE End time 

Description:    This command will get or set the SMPTE end time. 
 
Parameters:    hh = hours 
   mm = minutes 
   ss = seconds 
   ff = frames 
 
Get Command:  ET 
Response:  hh:mm:ss.ff 
 
Example:  Command: ET  

Response: 01:00:00.00 
 
 
Set Command:  hh:mm:ss.ffET 
Response:  R 
 
Example:  Command: 01:00:00.00ET  

Response: R 
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Get/Set SMPTE Loop Mode 

Description:  This command will get or set the current SMPTE loop mode. 
 
Parameters:    x = mode number: 
    0 = SMPTE looping is Disabled on power up 
    1 = SMPTE looping is Enabled on power up 

 
Get Command:  LM 
Response:  x 
 
Example:  Command: LM  

Response: 1 
 
Set Command:  xLM 
Response:  R 
 
Example:  Command: 1LM  

Response: R 
 
 
 
 
 

Get/Set SMPTE Powerup Mode 

Description:    This command will get or set the current SMPTE power up mode. 

 
Parameters:    x = mode number: 
    0 = SMPTE Disabled on power up 
    1 = SMPTE Enabled on power up 
 
Get Command:  PM 
Response:  x 
 
Example:  Command: PM  

Response: 1 
 
Set Command:  xPM 
Response:  R 
 
Example:  Command: 1PM  

Response: R 
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Get/Set SMPTE Restart Mode 

Description:    This command will get or set the current SMPTE restart mode. 
 
Parameters:    x = mode number: 
    0 = SMPTE restart is Disabled on power up 
    1 = SMPTE restart is Enabled on power up 
 
Get Command:  RM 
Response:  x 
 
Example:  Command: RM  

Response: 1 
 
Set Command:  xRM 
Response:  R 
 
Example:  Command: 1RM  

Response: R 

 
 
 
 

Get/Set SMPTE Idle Mode 

Description:    This command will get or set the current SMPTE idle mode. 
 
Parameters:    x = mode number: 
    0 = SMPTE output is active when idle 
    1 = Mute SMPTE output when idle 
 
Get Command:  IM 
Response:  x 
 
Example:  Command: IM  

Response: 1 
 
Set Command:  xIM 
Response:  R 
 
Example:  Command: 1IM  

Response: R 
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Get/Set Video Format 

Description:   This command will get or set the current video mode of the Binloop.  This 
command determines internal clocks in the Binloop, which in turn determines the 
available framerates for the reproducers.  Note that you still must configure the 
resolution and framerate of the individual reproducers. 

 
Parameters:    x = mode number: 
    0 = NTSC 29/59 
    1 = PAL 25/50 
    2 = FILM 23/47 
    3 = FILM 24/48 
    4 = NTSC 30/60 
 
Get Command:  VF 
Response:  x 
 
Example:  Command: VF  

Response: 0 
 
Set Command:  xVF 
Response:  R 
 
Example:  Command: 0VF  

Response: R 
 
 
 

Get/Set Synchronous Play Delay 

Description:   This command configures the synchronous play delay of the Binloop 
reproducers.  By default, this delay is 60 SMPTE frames, or around 2 seconds at 
29.97fps, but this setting allows you to override that default if necessary.  Be 
warned that decreasing this delay too much will result in synchronization 
problems.  The reproducers must have adequate time to load the video clip 
before it is capable of starting playback. 

 
Parameters:  nnn is a number between 0-127 that represents the S-Play delay setting 
    0 – Use Reproducer Default Delay (60 Frames) 
    1-127 – Delay (in frames) 
 
Get Command:  SD 
Response:  nnn 
 
Set Command:  nnnSD 
Response:  R 
 
Example:  Set S-Play Delay to 16 frames:    16SD 
   Set S-Play Delay to the Reproducer Default:  0SD 
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Search Clip 

Description:   This command causes the Binloop to preload the specified video clip and then 
pause on the first frame of the video.  After this happens, the next Play command 
causes the video file to start playing from the first frame onward. 

 
Command:  nnnnaaaSE 
 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 
    Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Examples:  Search File 1 on Reproducer #2: 1R2SE  
   Search File 2 on Group #1:  2G1SE 
   Search File 150 on 4K Group #2  150F2SE 
   Search File 52 on All Reproducers: 52*SE 

Play / Resume 

Description:   This command will start playing a clip that was previously loaded by a Search 
Clip command.  This command will also resume playback when the reproducer 
has been stilled or paused. 

 
Command:  aaaPL 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Search File 1 on 4K Group #2:   1F2SE 
   Play pre-searched file on 4K Group #2   F2PL 
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Loop / Resume 

Description:   This command functions just like the Play / Resume command except that the 
video loops once the end of the clip is reached.  

 
Command:  aaaLP 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Search File 1 on 4K Group #2:   1F2SE  
   Loop pre-searched file on 4K Group #2:  F2LP 

Play Clip 

Description:   This command will play the specified clip on the addressed reproducer card(s).  
Playback starts as soon as possible after the command is received. 

 
Command:  nnnnaaaPL 
 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 
    * - Wildcard address for all reproducers 

 
Response:  R 
 
Comments: Since playback starts as quickly as possible once this command is received, it 

should never be used for synchronous playback.  For this, you should use the 
Synchronous Play command, or a search commands followed by a Play/Resume 
for a consistent synchronized start of playback. 

 
Examples:  Play File 3 on Reproducer #1:  3R1PL  
   Play File 4 on Group #2:   4G2PL 
   Play File 52 on All Reproducers:  52*PL 
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Loop Clip 

Description:   This command functions exactly like the Play Clip command, except that the 
video loops once the end of the clip is reached. 

 
Command:  nnnnaaaLP 
 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Examples:  Loop File 3 on Reproducer #1:  3R1LP  
   Loop File 4 on Group #2:  4G2LP 
   Loop File 52 on All Reproducers: 52*LP 
 
 
 

Synchronously Play Clip 

Description:   This command functions exactly like the Play Clip command, except that the 
playback does not begin as quickly as possible.  Instead, the reproducer waits a 
consistent amount of time (60 SMPTE frames by default) after the command is 
received before it starts playback.  This ensures that all reproducers that receive 
this command at the same time, start playing at the same time. 

 
Command:  nnnnaaaSP 
 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Comments: This command is almost always addressed to either a Group or All reproducers 

to ensure that they all start playing synchronously. 
 
Examples:  Synchronously Play File 2 on Group 1:  2G1SP  
   Synchronously Play File 2 on 4K Group 1: 2F1SP 
   Synchronously Play File 2 on All Reproducers: 2*SP  
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Synchronously Loop Clip 

Description:   This command functions like the Synchronously Play Clip command, except that 
the video loops once the end of the clip is reached. 

 
Command:  nnnnaaaSL 
 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Examples:  Synchronously Loop File 2 on Group 1:  2G1SL  

Synchronously Loop File 2 on 4K Group 1: 2F1SL 
   Synchronously Loop File 2 on All Reproducers: 2*SL  
 
Comments: If you plan to synchronously loop files on multiple reproducers, the video clips 

MUST be identical in length (down to the frame).  If they are not, the clips will not 
remain in sync after the loop point. 

 
 
 

Play Next  

Description:   This command causes the specified file to be "queued" for playback at the 
completion of the current video clip.  If a file is currently playing, the queued 
transition to the selected file will be seamless.  If a file is currently looping, the 
seamless transition will occur at the next loop point.  If a video is not currently 
playing, the video specified in this command will begin playing immediately. 

 
Command:  nnnnaaaPN 
 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Play File #2 on Reproducer 1:   2R1PL  

Queue File #3 to play after file #2 finishes: 3R1PN 
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Loop Next  

Description:   This command functions exactly like the Play Next command except that the 
queued file loops after it finishes playing. 

 
Command:  nnnnaaaLN 

 
Parameters:  nnnn is an ASCII file number between 0-1023 
   aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Play File #2 on Reproducer 1:   2R1PL  

Queue File #3 to loop after file #2 finishes: 3R1LN 
 

 

Stop Playback 

Description:   This command will stop currently playing clip.  After playback stops, the last 
frame that was displayed will remain on screen. 

 
Command:  aaaRJ 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Examples:  Stop Reproducer #1:  R1RJ  
   Stop Group #2:   G2RJ 
   Stop 4K Group #1:   F1RJ 

Stop All Reproducers:  *RJ 
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Still Playback 

Description:   This command will pause the currently playing clip at its present position. The 
stilled video frame will remain on screen.  

 
Command:  aaaST 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Still Reproducer #1:  R1ST 
   Resume Reproducer #1: R1PL   
  

Pause Playback 

Description:   This command will pause the currently playing clip at its present position. The 
screen will mute to black while the video is paused (this is the only difference 
between the Pause and Still commands).  When the Play/Resume command is 
used after this command, the video is unmuted and restored automatically. 

 
Command:  aaaPA 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Pause Reproducer #1:  R1PA 
   Resume Reproducer #1: R1PL 
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Mute/Unmute Video 

Description:   This command controls muting on the video outputs of the Binloop.  When 
muted, the video outputs are black.  When unmuted, the video outputs display 
video normally. 

 
Command:  naaaVD 
 
Parameters:  n is a number between 0-1 that represents the mute state 
    0 – Muted (black output) 
    1 – Unmuted (normal output) 

aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Mute Video on Reproducer #1:  0R1VD 
   Unmute Video on Reproducer #1: 1R1VD 
 

Enable/Disable Video 

Description:   This command controls the video output of the Binloop’s reproducers.  When 
disabled, there is no signal being driven from the HDMI/SDI connectors of the 
selected reproducers.   

 
Command:  naaaVE 
 
Parameters:  n is a number between 0-1 that represents the mute state 
    0 – Disabled (no video output) 
    1 – Enabled (normal video output) 

aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Response:  R 
 
Example:  Disable Video on Reproducer #1: 0R1VE 
   Enable Video on Reproducer #1: 1R1VE 
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Set/Clear On-Screen Label 

Description:   This command will enable, disable, and set the text of an onscreen label, applied 
to the top-left corner of the video outputs.  To remove the label, send this 
command with a blank string.  Labels can be up to 16 ASCII characters in length. 

 
Command:  s7aaaOS 
 
Parameters:   

s is a string of up to 16 ASCII characters to be displayed on-screen.  Leave this 
parameter empty to clear the label from the screen. 
aaa is the address of the card(s) you want to process the command 

    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Comments: This command requires a minimum reproducer firmware version of v1.20 and a 

minimum controller (DBAP5) version of v2.46. 
 
Response:  R 
    
Example:  Display “myLabel” on reproducer 1:  myLabel7R1OS 
   Clear the label from the video outputs:  7R1OS 
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Set HD Video Format 

Description:   This command configures the video format for the outputs of the specified 
reproducer(s).  If using the Binloop as a 4K player, set the desired 4K group to 
1080P for a total resolution of 3840x2160, or 2K for a total resolution of 
4096x2160. 

 
Command:  fffffaaaVO 
 
Parameters:  fffff is one of the following strings 
    1200P60 – 1920x1200 @ 60fps (only in 4:4:4 mode, HDMI only) 
    2KP60 – 2K(2048x1080) @ 60fps 
    2KP59 – 2K(2048x1080) @ 59.94fps 
    2KP50 – 2K(2048x1080) @ 50fps 

2KP48 – 2K(2048x1080) @ 48fps 
2KP47 – 2K(2048x1080) @ 47.952fps 

    2KP30 – 2K(2048x1080) @ 30fps 
2KP29 – 2K(2048x1080) @ 29.94fps 
2KP24 – 2K(2048x1080) @ 24fps 
2KP23 – 2K(2048x1080) @ 23.976fps 
1080P60 – 1080p @ 60fps 

    1080P59 – 1080p @ 59.94fps 
1080P50 – 1080p @ 50fps 
1080P48 – 1080p @ 48fps 
1080P47 – 1080p @ 47.952fps 
1080P30 – 1080p @ 30fps 
1080P29 – 1080p @29.97fps 
1080P24 – 1080p @24fps 
1080P23 – 1080p @23.976fps 

   720P59 – 720p @ 59.94fps 
720P50 – 720p @ 50fps 

aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
    Gxx – Group address between G1-G13 

Fx    – 4K Group, F1 or F2 
    * - Wildcard address for all reproducers 
 
Comments: For the HD Video Format to be successfully applied, the A/V Binloop 

Uncompressed cage must be configured with a compatible “A/V Video Format”.  
For instance, to set a reproducer to 1080P, 48fps – the cage must be configured 
for “FILM 24/48”.  See the “Get/Set Video Format” command. 

 
Response:  R 
 
Example:  Set Reproducer #1 to 1080p @ 59.94fps: 1080P59R1VO 
   Set 4K Group #2 to 3840x2160 @ 59.94fps: 1080P59F2VO 



 

Alcorn McBride A/V Binloop Uncompressed User’s Manual Page 41 

 

Get Reproducer Firmware Version 

Description:   This command requests the firmware version of the specified reproducer.  If the 
specified reproducer is not installed in the Binloop, there will be no response.   

 
Command:  aaa?V 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
 
Response:  REPRO-2KU Vx.xx 
    
Example:  Request firmware version of Reproducer #1: R1?V 
 
Example Responses: Reproducer with V1.00:    REPRO-2KU V1.00 
      
 

Get Reproducer Status 

Description:   This command requests the playback status of the specified reproducer.  If the 
specified reproducer is not installed in the Binloop, there will be no response.  
Keep in mind that using this command will briefly tie up the Reproducer 
communication interface, so it is not recommended for use immediately before or 
after time-sensitive commands (like Synchronous Play).   

 
Command:  aaa?P 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
 
Response:  Pnn 
 
Parameters:  nn is a number that represents the status of the reproducer 
    P00 – Error (Fault) 
    P01 – Stopped 
    P04 – Playing 
    P05 – Stilled 
    P06 – Paused 
    P07 - Searching 
     
Example:  Request status of Reproducer #1:  R1?P 
 
Example Responses: Reproducer is Playing:    P04 
   Reproducer is Stopped:    P01 
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Get Reproducer Clip Number 

Description:   This command requests the number of the clip currently playing in the specified 
reproducer.  The clip number is the number included in the directory name of the 
directory that contains the image sequence.  If the specified reproducer is not 
installed in the Binloop, there will be no response.  Keep in mind that using this 
command will briefly tie up the Reproducer communication interface, so it is not 
recommended for use immediately before or after time-sensitive commands (like 
Synchronous Play).  If a clip is not playing, the response will be the last 
played clip. 

 
Command:  aaa?C 
 
Parameters:  aaa is the address of the card(s) you want to process the command 
    Rxx – Reproducer address between R1-R8 
 
Response:  xxxxxxxx.xxx 
    
Example:  Request clip name of Reproducer #1:  R1?C 
 
Example Responses: Clip number is 128:    128 
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Binloop Configuration Software 

 

Introduction to the Binloop Software 

The Binloop Configuration Software is a Windows application that 
provides an easy-to-use interface for programming and configuring the 
Binloop.  While it’s true that most of the Binloop’s configuration settings 
can be accessed from the front-panel Menu Wheel interface, the Binloop 
application provides a more visual alternative for configuring these 
settings.  In addition, this software is necessary to program SMPTE 
timecode triggers for applications where you want the Binloop to operate 
without any external control system. 

 

Requirements 

The Binloop software requires that you have PC running Microsoft 
Windows XP, Vista, 7, 8, or 10.  This PC must have either an Ethernet 
port and/or an RS-232 Serial port so that it may communicate with the 
Binloop. 

 

Installing the Binloop Software 

If you have Internet access, we recommend downloading the latest 
version from the Alcorn McBride website at http://www.alcorn.com.  
Once you locate the installation file, simply run it on your Windows PC 
and follow the on-screen instructions. 
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Connecting your PC to the Binloop 

There are two ways in which the Binloop software can interface to the 
Binloop from your PC: 

1. Ethernet  

2. RS-232 Serial 

 

Connecting with RS-232 Serial 

If your PC is not equipped with 
an RS-232 serial port, you can 
use a USB-to-Serial adapter.  
Just make sure that the 
adapter will support “Mark-
Space Parity” operation.   

For a list of USB-to-Serial 
adaptor manufacturers that 
support this protocol visit 
www.alcorn.com and use our 
Knowledge Base. 

The Binloop software can communicate with the Binloop through a PC 
Serial Port via a 9-pin straight-through serial cable (included with the 
unit).  Before this can happen, you must first connect the serial cable 
between a serial port on your PC and the Programmer port of the 
Binloop. 

Once you make this connection, you are ready to use the Binloop 
software to program and communicate with the your Binloop. 

 

 

Connecting with Ethernet 

Ethernet is also a common method of interfacing the Binloop software to 
the Binloop.  This requires a PC to be connected to the Binloop directly, 
or over a network, using a CAT5 (or better) rated Ethernet cable.  When 
the Binloop has a good network connection, the green Link LED will 
illuminate. 

Beyond a good physical connection, Ethernet communication requires 
properly configured network settings on both the Binloop and your PC.  
Although Ethernet network design and administration is beyond the 
scope of this manual, we have provided a step-by-step guide in this 
manual that will walk you through connecting directly to the Binloop over 
Ethernet using the Binloop’s default settings.  Please refer to the 
Application Notes section if you would like more information on this. 

 

http://www.alcorn.com/
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Running Binloop Software 

The Binloop Icon on your 
Desktop looks like this: 

 

Start the program by double-clicking the Binloop icon that was put on 
your desktop during the installation.  The program can also be 
launched from the Windows Start menu from the Programs→Alcorn 
McBride Inc folder.  When the program opens, you’ll see this 
window… 

 

 

 

 Before we get started, you’ll need to configure your PC’s connection 

with the Binloop.  To do this, click on the  icon at the top of the 
Binloop window. A window will appear that will allow you to choose 
your preferred connection method.   

 

If you intend to communicate with RS-232, you must select the Serial 
option and specify the COM port in your PC that is connected with the 
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Binloop.  If you are using Ethernet, you must select Ethernet as the 
communication method and then enter the Binloop’s IP address in the 
provided box.  Once you have setup the appropriate connection, click the 
OK button to close this window. 

To make sure that the connection is working properly, click on the  
icon at the top of the Binloop window.  This will open the Unit 
Configuration window you see below.   

 

 

 

Click on the Detect button.  If the connection is working properly, the 
Version box will display the current version of the Binloop’s controller 
card.  If this is not the case, please refer to the Troubleshooting Guide 
for assistance. 
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Controlling the Binloop with the Binloop Software 

 

 

Note: Please refer to the 
Media section of this manual 
for more information on 
creating your own videos and 
file naming conventions for the 
Binloop. 

Now that you are connected to the Binloop using the Binloop 
Software, let’s go through an example of how you can use this 
software to control the Binloop in real-time.  Specifically, this example 
will demonstrate how to command the Binloop to play a video file.  
Before we get started, it is assumed that you already have a known-
working video assigned as clip #1 loaded onto the SSD of reproducer 
#1.  It is also assumed that the outputs of reproducer #1 are properly 
connected to a video display.  If these assumptions frighten you, then 
you should refer to the Playing a Test Video guide located in the 
Getting Started section of this manual before moving on. 

1. Make sure that Reproducer 1 has a flash card loaded with a 
video clip named as clip 1 (i.e. VID00001). 

2. Make sure that the Binloop, your video display, and your audio 
system are powered on. 

3. Select Binloop→Reproducer→Controls from the menu of the 
Binloop Software. 

 

This window serves as an 
interface for manually 
controlling the Binloop.  This 
lets you test the functionality of 
the Binloop before you apply 
that functionality to any of the 
Binloop’s other control 
interfaces.   

 

If you try to play a file that does 
not exist on the media the Red 
Error LED on the Reproducer 
Flashes rapidly 

 

 

4. Select Reproducer 1 from the list on the left-hand side. 
Assuming that the number of the video file you want to play is 1, 
you can leave the Segment number as the default (1). 

5. In the Reproducer 1 Controls window, use the buttons to control 
the playback. 

6. Click on the Play button to start the video.  The status LED of 
reproducer 1 will turn green. 

7. Click on the Stop button to stop the video 
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Navigating through the Menus 

File Menu 

The first selection in the main menu is the File menu, which allows you 
to access .AMB Binloop files.  These files hold all of the Binloop 
configuration and playback parameters including address, sample clock 
frequency, SMPTE frame rate, and timecode triggers.      

New 

 

 

The first selection, New, creates a new Binloop configuration with 
default values and an empty timecode trigger list.  

Open… 

The second selection is Open… which pops up a window allowing you to 
open a previously saved file containing all of your program settings.  
Previously-stored files are recalled by browsing to the correct directory 
location and selecting the saved file name. 

 

 

Clicking on OK without selecting a file does not initiate any action.  
Clicking on Cancel closes the window without opening any file or 
changing any settings. 
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Save 

The Save option causes one of two actions.  If you are using a file which 
was previously saved, choosing this option will immediately save the file 
with the same name and update the saved version with the new 
information, replacing the old version.  If you are using a new file which 
has not yet been saved, will present the Save window.  This window 
allows you to name your configuration file and choose a location to store 
it.  The Save window is identical to the Save As window. 

 

Save As… 

The Save As… option displays a window allowing you to save your 
current settings in a file with a new name. 

The file name defaults to the name of the file you are currently using.  
The name can be changed from the default by typing a new name into 
the File name box.   

 

Print Setup… 

The Printer Setup… selection allows you to select and configure your 
printer. 

Once you’ve programmed some timecode triggers (explained later in this 
chapter) options for printing the table appear in this menu. 

 

Print… 

The Print selection prints the timecode trigger list contained in the AMB 
file that you’re currently viewing. 

 

Print Preview… 

The Print Preview option shows what the timecode trigger list printout 
will look like before you actually print it. 

 

Exit 

The final option in the File sub-menu is Exit.  This allows you to exit the 
program and returns you to Windows.  If you have made any changes to 
the settings, you will be asked if you want to update the unit and if you 
want to save the file with the current settings before you exit the Binloop 
application.   
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Binloop Menu 

The next selection in the main window is Binloop.  It contains two groups 
containing selections called Settings…, SMPTE…, Reproducer, and 
Download to Binloop and Upload to Binloop.  Each of these selections is 
explained in what follows. 

Settings…Unit… 

 

Reproducer Card Slots 

Many previous generations of 
Binloop products are supported 
by the Binloop Software.  

The Unit Configuration window permits the user to select the number 
of reproducers in the Binloop.  The A/V Binloop Uncompressed has 8 
slots. 

 

Control Port Protocol 

The Control Port Protocol determines the protocol that is used on the 
Show Control Port.  These settings can be either Alcorn Show 
Control(Alcorn 9-bit), MIDI, ASCII (Pioneer/AMI), and Debug.  For more 
information on these protocols, please refer to the Control Protocols 
section of this manual. 

Unit Number 

The Unit Number is the device address used for the MIDI protocol and 
when addressing multiple units. 
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Unit Groups 

You can place the Binloop into a Group with other Binloops and address 
them as a single group.  The Unit Groups selects which groups this 
Binloop is a member of. 

 

Settings…Connection… 

 

 

This Connection Settings window provides settings for the serial COM 
port your using on your PC to communicate to the Binloop.  It defaults to 
Offline. 

 

SMPTE…Start… 

 

 

You can also set a Custom 
Preroll Time where SMPTE 
Generation can begin earlier 
the first time it is started. 

This window presents you with a Start button for starting the SMPTE 
interface.  This window will change depending on whether you have 
the SMPTE interface configured to Generate or Read SMPTE. 
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SMPTE Stop… 

This option stops the SMPTE interface as well as the reproducers.  A 
confirmation window appears with OK and Cancel. 

 

SMPTE Configuration… 

The SMPTE Configuration window allows you to set all of the parameters 
associated with the Binloop’s SMPTE interface. 

 

Frame Rate 

This is the Frame Rate used for generating SMPTE.  The choices are 
23.976, 24, 25, 29.97, 30-drop, and 30 frames-per-second. 

Read External SMPTE 

This button configures the SMPTE interface to Read incoming SMPTE 
from the SMPTE In connector. 

Generate SMPTE 

This button configures the SMPTE interface to Generate timecode.  This 
timecode is used internally to process the timecode triggers, and is also 
fed to the SMPTE Out connector. 
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Genlock to Video 

Only 23.976, 25 (PAL) and 
29.97(NTSC) frame rates are 
supported when in Genlock to 
Video mode. 

Since the A/V clock interface of 
the Binloop can lock to an 
external V-Sync source, this 
means that you can generate 
SMPTE synchronously with 
your video sync source as well. 

When this option is selected, the SMPTE interface will generate 
timecode synchronously with the internal V-Sync clock of the Binloop.  
This ensures that the SMPTE clock and reproducers operate at the 
same exact rate. 

Since the SMPTE clock is used as a timing reference for timecode 
triggers, it’s recommended that this option is enabled whenever you 
are synchronizing multiple video tracks.  This will ensure that the 
reproducers start reliably in sync with one another. 

Start Automatically on Power UP 

If this checkbox is active the Binloop will begin Generating or Reading 
timecode as soon as the system reaches the ‘Ready’ state.   

Preroll Time 

This is the timecode value at which the SMPTE generator will begin 
when first started.  

Start Time 

This is the time at which SMPTE timecode will loop back to when it is 
looping, or when a restart condition has occurred. 

End Time 

This is the time at which SMPTE will stop or loop (depending on the 
Loop setting). 

Loop SMPTE at End Time 

If this option is enabled, then the SMPTE generator will loop back to the 
Start Time when the End Time is reached. 

Allow Start Input to Restart SMPTE 

When this option is enabled, a SMPTE Start command from any control 
interface will cause the SMPTE generator to jump back to the Start Time. 

SMPTE Muted When Stopped or Paused 

When SMPTE is paused or stopped, SMPTE output will be muted when 
this checkbox is active.  If this checkbox is inactive, the current frame will 
be repeated over and over again when timecode is paused or stopped. 

Version – Get Version 

This allows you to get the current firmware version of the SMPTE 
interface on your Binloop’s Controller card. 
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Reproducer…Controls… 

When you select this menu item, the Reproducer Controls window 
appears.   

 

This window presents many controls that are good for playback testing 
and troubleshooting.  Each is explained below. The next menu item 
allows you to select an individual Reproducer to control. 

Reproducer Address 

This option changes which Reproducer or Reproducer Group you are 
configuring / accessing. 

Controls 

Play 

This will cause the selected Reproducer to Play the selected file 
segment.  Clicking Play again will start playback over from the 
beginning. 

Pause 

This causes the currently playing file to stop and blank the screen.  
Clicking Play will cause it to continue playback from where it was 
paused. 

Stop 

This will cause the selected Reproducer to Stop the selected file 
segment.  Clicking Play again will start playback over from the 
beginning. 

Still 

This will cause the selected Reproducer to Still the selected file 
segment, but leave the last frame played up instead of blanking the 
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screen.  Clicking Play will cause it to continue playback from where it 
was paused. 

Loop 

This will cause the selected Reproducer to Loop the selected file 
segment.  Clicking Loop again will start playback over from the 
beginning. 

Play Next 

If a file is currently playing, clicking the Play Next button will 
queue the specified file segment to play immediately after the 
current file is finished playing. 

Loop Next 

If a file is currently playing, clicking the Loop Next button will queue 
the specified file segment to play in loop immediately after the 
current file is finished playing. 

Clip 

Please refer to the Media Files 
section of this manual for the 
correct way to name and 
number files. 

The Clip refers to the particular video file that you want to play.  It is a 
number referring to the file number on the media. 

Search 

You can Search a video file so that when you click Play it will begin 
playing immediately.  Since the A/V Binloop Uncompressed does not 
support playing video from an offset, the offset value should always 
be 00:00:00.00. 

Search 

Colorspace 

RGB is actually RGBs w/ sync 
on green. 

This setting allows you to configure the component video output 
Colorspace as either RGB or YUV. 

 

 

Output Format 

This setting allows you to change the output format of the video 
that is playing. 
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Configuration 

Product / Detect 

Here you can select the Product you are configuring manually or 
click Detect to have the Product and Version be detected for you. 

Media Utilities 

Important: You should always 
Format the media in the 
Binloop before you use it.  

This button accesses another window that allows you to Format the SSD 
media on the selected Reproducer.  Formatting will erase the contents of the 
drive. 

 

 

Pressing Detect will fetch the current network settings on the 
card. 

Reproducer IP 

Here you can set the IP for the Reproducer.  

Reproducer Gateway 

Here you can set the Gateway for the Reproducer. 

Reproducer Subnet Mask 

Here you can set the Subnet Mask for the Reproducer. 
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Reproducer Groups 

Note: By grouping the 
reproducers together, 
Reproducers can be 
simultaneously commanded 
using any of the Binloop’s 
control interfaces. 

Reproducers can be assigned to Groups using this selection.  A 
Reproducer that is a member of a Group will respond simultaneously 
with other members to any command that is addressed to the Group.  
This provides the ability for one Play command to trigger synchronized 
multi-channel video playback. 

You can assign a Reproducer to be a member of more than one Group.  
Below is a screenshot showing the Group assignment window.  This 
example assigns Reproducers 5, 6, 7, and 8 to be members of Group 1. 

 

Configuration… 

You can determine that current playing configuration of each Reproducer 
by opening the Configuration window.  When this window opens, select 
the cards you want and click Detect and after a brief moment each 
Reproducer will report their current status. 

A Not Installed message appears if no Reproducer is installed in the slot.   
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Download to Binloop … 

Note: If the optional CobraNet 
card is installed, please 
disconnect the CobraNet 
interface before downloading 
the CobraNet configuration 
otherwise it may fail. 

This option allows you to download the configuration you are currently 
viewing.  This includes all of the SMPTE interfaces settings, unit 
configuration settings, as well as any programmed timecode triggers.  A 
confirmation window will appear. 

 

  

 

Upload to Binloop 

This option allows you to retrieve the configuration from an A/V Binloop 
Uncompressed, view it within the Binloop software.   When you click the 
Upload Configuration button you will be presented with a window asking 
you to select your Binloop and Reproducer type. 

   

 

View Menu 

The View button allows you to turn on or off the Tool Bar at the top of the 
main window, or the Status Bar at the bottom. 

 

Window Menu 

The Window button is a standard Windows control that allows you to 
open a New Window for Triggers, Cascade or Tile windows, and Arrange 
Icons. 
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Help Menu 

The Help sub-menu shows a window containing current revision 
information. 
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Timecode Trigger List 

The Timecode Trigger List is the portion of the Binloop software that 
allows you to program precisely timed commands that are triggered 
based on the Binloop’s timecode clock.  It has a row of button at the top 
that allow you to Add, Duplicate, Edit, or Delete triggers.  

 

Add 

Clicking Add brings up a window that allows you to add a trigger. 

 

Time 

This is the timecode value at which you want the trigger to occur. 

Triggers Window 
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Action 

This is the action (command) you want to have happen at the trigger 
Time.  Available selections are Play, Play Next, Pause, Still, Stop, 
Search, Start Sequence, and Set Variable. 

 

Action Description 

Play Plays a file (Synchronous Play). Also used to 
resume from a search, still, or pause. (segment 
number is ignored when used to resume) 

Play Next Queue a file to play when the current clip is 
finished. 

Pause Pause video playback, and mute video output 

Still Pause video playback, still frame remains on-
screen. 

Stop Stop playback 

Search Prepare a video for playback, first frame appears 
on-screen when search is complete. 

Start Sequence Send a Start Sequence command to an Alcorn 
McBride Show Controller out of the Show Control 
Port. (Show Control Port must be set to Alcorn 9-
bit) 

Set Variable Send a Set Variable command to an Alcorn 
McBride Show Controller out of the Show Control 
Port. (Show Control Port must be set to Alcorn 9-
bit) 

Loop 

Check this box if you want the Play trigger to be a Play-and-Loop 
command where playback will loop back to the beginning of the clip after 
the clip ends. 

Location 

You can have the Action apply either to an individual Reproducer, a 
Reproducer Group, or All Reproducers. 

Number 

This is either the Number of the individual Reproducer or Reproducer 
Group selected in the Location.  This field is disabled when All 
Reproducers is selected. 

Socket 

This field is used for older Binloop systems that have multiple flash 
memory sockets.  This value is not relevant for the A/V Binloop 
Uncompressed. 
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Segment 

This is the number of the video clip that you want to play (for Play 
triggers). 

Offset 

 This field is used for reproducers that support playback from a specified offset 
into a video file.   
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A Word About Trigger Latency: 

The Binloop uses two different types of Play commands.  The first one, 
called “Unsynchronized Play” is used mostly for “point-source” or other 
audio/video applications where synchronization between channels is not 
important.   

The other type of Play command is called “Synchronous Play”.  This 
command needs to be used in those situations where absolute frame 
synchronization is required across channels.  This is the type of play 
command issued by the Play action.  There are important differences 
between how the Binloop reacts to these two commands. 

Unsynchronized Play Latency 

When this type of play command is sent to a reproducer, it starts playing 
the file as soon as it possibly can.  The latency is determined only by the 
amount of time it takes the reproducer to process the play command, 
load the clip from the SSD, and begin decoding and playing the file.  This 
latency is very short, but it is not predictable.  For that reason, this 
command is not recommended for use when the goal is to synchronize 
playback between multiple reproducer cards.  The unsynchronized play 
command is normally used for applications that require multiple channels 
of video that are unrelated to one another (like individual kiosks, etc.). 

Synchronized Play Latency 

The exact amount of latency 
time will depend on the 
SMPTE frame rate being used. 

 

When using Play commands 
from the Timecode trigger list, 
it is highly recommended that 
the SMPTE clock is locked to 
V-Sync.  This ensures that the 
timecode framerate and the 
video framerate of the 
reproducers is synchronous. 

A Synchronized Play is the same as an Unsynchronized Play with one 
key difference.  Rather than playing the video as quickly as possible, 
the reproducer will wait a consistent amount of time after the play 
command was received before playback starts.  This ensures that 
every reproducer that received this command starts playing at the 
same time. 

The latency between when the play command occurs and when the 
file actually starts playing is exactly 2 seconds for a Synchronized 
Play.  This delay provides the reproducer with more than adequate 
time to process the command and load the video from the SSD so 
that it’s ready to start playing when the consistent wait period is over. 

Use the Synchronized Play command for playing groups of Reproducers, 
which must start playback in perfect synchronization (i.e. video wall 
presentations, or 4K playback).
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Hardware Description 

 

Controls and Indicators 

The Binloop is normally controlled either internally using a configuration 
loaded from our Binloop software, or remotely from an external control 
system. However, the product does have several controls and status 
indicators located on the front panel.  

 

Unit Status LED’s 

On the front of the Binloop are nine LED's corresponding to the status of 
the unit.  Below is a brief description of their meaning: 

 

 

 

Power (Green) - Power is being applied to the unit. 

Fault (Yellow) - The unit has detected a fault condition. 

Lock (Red) - The unit is has detected an external sync source (video 
by default) and is locked to it.  This lock can also be from 
SMPTE/GPS. 

Gen (Red) - The unit is actively generating SMPTE timecode. 

Ready (Red) - The unit is ready to accept commands.  This LED 
should almost always be on. 

Run (Red) – This indicator is illuminated whenever the SMPTE output 
is active. 

Pause (Red) - This LED is illuminated during SMPTE generation 
when the Pause button has been pressed and a Pause at the SMPTE 
End or Loop Time is pending. 

Stop (Red) - This is illuminated whenever the SMPTE 
Generator/Reader is idling and ready to begin SMPTE generation or 
external SMPTE synchronization. 
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Control Buttons  

Directly beneath the Unit Status LED's, there are four control buttons.  
Their functions are defined briefly here but they will be discussed in more 
detail over the course of the next two chapters: 

 

 

 

 

 

 

 

 

 

 

 

 

Start - If the Binloop is programmed to generate SMPTE, pushing 
this button starts the generation of timecode.  If the Binloop is 
programmed to read external timecode, this causes the unit to start 
listening for external timecode.  If SMPTE is already being 
generated, this button can be optionally configured to restart the 
SMPTE clock. 

Pause – This button is only applicable when the Binloop is 
configured to generate and loop SMPTE.  Pushing this button 
causes the SMPTE generation to pause the next time the 
configured End Time (the loop point) is reached.  After this button 
is pressed, the Pause status LED will illuminate. 

Reset – If the Binloop is configured to generate timecode, pushing 
this button halts the generation.  If the Binloop is configured to read 
external timecode, this button causes the Binloop to ignore any 
incoming timecode.  In addition, pressing this button stops 
playback on all reproducers. 

Unused – This button has no purpose. 

 

 

Reset to Factory Defaults  

This will clear ALL user settings and will load factory defaults.  To reset 
to factory defaults: 

1. Turn off the Binloop 

2. Hold down the first three Control Buttons: Start, Pause and 
Reset. 

3. Turn the Binloop back on while still holding down these buttons. 

4. You should see “DEFAULTS LOADED REBOOTING…” within 5 
seconds. 

5. Release the buttons and wait for the Binloop to initialize.  The 
first boot after defaults are loaded will take a bit longer than a 
regular boot sequence.  Do not be alarmed. 
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Display and Menu Wheel 

The Binloop is equipped with 2x16 character LCD Display.  This display 
is primarily used to indicate the current status of the Binloop.  Here’s an 
example of that status display: 

 

The current SMPTE mode is indicated at the top-left of this screen.  The 
3 possible modes are displayed as Gen, Gen* (Generate /w V-Sync), 
and Read.  The current state of the SMPTE generator/reader is 
displayed at the bottom left, and the SMPTE frame rate is displayed at 
the bottom right.  The time at the top-right of the display represents the 
current SMPTE timecode value in hours, minutes, seconds, and frames.  
In the event that there is no current timecode value (meaning timecode is 
not currently being read or generated), this time will be displayed as 
dashes like the following example: 

 

In addition to providing system status, the display can also be used in 
conjunction with the nearby Menu Wheel to access the configuration 
settings of the Binloop.  To enter this menu, simply press in the menu 
wheel.  

 

Note: The menu wheel ‘clicks’ 
when rotated to provide tactile 
feedback between selections.  

 

 

After you do this, you can navigate through the various settings of the 
Binloop by rotating the menu wheel to change the selection, and 
pressing it to select the current item.  When you are finished, simply 
browse to the ‘Exit’ selection and push the menu wheel to return to 
the status screen.  To see a complete map of this menu interface, 
refer to Appendix D - Wheel Menu Map. 
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Reproducer Status LED 

Each reproducer has a single multi-color LED located directly above the 
SSD slot.  The color and blink pattern of this LED signifies the current 
state of the reproducer   Here’s a table of those states and the 
corresponding LED behavior: 

 

LED State Reproducer State 

Off Stopped 

Green Playing 

Orange Paused, Stilled, or Searched 

Flashing Red Fault 

Pulsing Green Power-on Initialization 

Pulsing White Firmware Update 

Pulsing Orange Formatting SSD 

 

 

Reproducer Test Button 

 

 

 

 

 

 Each reproducer has a test button located directly above the SSD slot.  
As you can probably tell from the name, this button is intended only for 
testing purposes and not for normal operational control.  When this 
button is pressed, the reproducer reacts differently depending on its 
current state.   

Note: Clip Number 1 is  
VID00001.  Please refer to the 
Media Files chapter in this 
manual for further details on 
clip naming. 

1. If the reproducer is stopped, pressing this button will cause the 
lowest numbered file to start playing. 

2. If the reproducer is playing, pressing this button will cause it to 
stop playing. 

3. If the reproducer is in a fault condition (status LED flashing 
red), pressing this button will clear the fault. 
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Connectors 

This table lists all connectors on the Binloop Card Cage and their related 
function.  The connectors are all located on the rear of the Binloop.  If the 
connector is a single signal, then the signal is listed.  If the connector 
contains multiple signals, the connector's pins are identified in further 
tables. 

Connector Summary 

 

Connector Type Function 

3G-SDI BNC Female (up to 8) SMPTE 424M 3G-SDI Digital Video Outputs 

HDMI HDMI Female (up to 8) HDMI Interface for Digital Video 

Show Control DB-9/M RS-232 to Control System 

Programmer Port DB-9/M RS-232 to Programmer 

VSYNC BNC Female Blackburst Video Sync Input 

SMPTE DB9/F SMPTE Input/Output 

Parallel Control DB37/F Control and I/O 

Ethernet RJ-45 Ethernet Control 

Show Control Port 

The Show Control serial port is intended for applications where the 
Binloop is to be controlled remotely via an RS-232 capable control 
system.  This could be an Alcorn McBride show controller, a PC, or 
practically any device with an RS-232 serial port.  Since this interface is 
designed to be flexible, it supports a variety of different serial protocols.  
These protocols include Alcorn 9-bit, Pioneer/AMI, and MIDI .  For 
more information on how to use the serial control interface, please refer 
to the section titled Controlling the Binloop. 

 

Pin Signal 

1 N/C 

2 RXD 

3 TXD 

4 N/C 

5 GND 

6 – 9 Not Used 
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Programmer Port 

The Programmer serial port is specifically intended to connect with a PC 
serial port for configuring and programming the Binloop using the Binloop 
software.  This connection should be made with a straight-through (not 
null) 9-pin serial cable, which is included with the Binloop. 

 

Pin Signal 

1 N/C 

2 TXD 

3 RXD 

4 N/C 

5 GND 

6 – 9 Not Used 

 

Ethernet 

The Ethernet jack of the Binloop is intended to connect the Binloop to a 
10/100 Ethernet network.  This interface can be used by the Binloop 
Configuration software to control the Binloop as well as download new 
configurations.  For other methods of Ethernet control, this interface also 
provides a simple control interface that uses the Pioneer/AMI protocol 
over the common Ethernet protocol called UDP.  For more information 
on how to use the Ethernet interface of the Binloop, please read the 
section of this manual called Controlling the Binloop. 

 

V-Sync 

The V-Sync connector is a female BNC connector that is designed to 
accept a blackburst video sync signal.  When a sync signal is applied to 
this connector, the A/V system of the Binloop will use this as a reference 
for all video generated within the Binloop.  For more details about using 
external video sync with the Binloop, refer to the A/V Sync System 
chapter in the About the Binloop section of this manual. 
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SMPTE 

The SMPTE connector provides both an input and output for the SMPTE 
interface of the Binloop.  The balanced input is 600 ohm transformer-
isolated and will accept levels between 1- 5 Vpp.  The balanced output 
level defaults to 0dBV into 150 ohms, but can be adjusted between 0-
4dBV using the front-panel menu of the Binloop.  For backward 
compatibility with previous Binloop systems, an alternate V-Sync input is 
also provided on this connector. 

 

Pin Signal 

1 SMPTEIN + 

2 SMPTEIN - 

3 N/C 

4 VSYNCIN 

5 GND 

6 N/C 

7 N/C 

8 SMPTEOUT- 

9 SMPTEOUT+ 
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Parallel Control 

This connector contains various inputs and outputs that can be used to 
control and monitor the Binloop.  Pins 7-14 are optically-isolated inputs 
designed to trigger on 24V.  Pins 20-37 are designed to accept a contact 
closure between the specified pin and a GND pin (16, 17, 18, or 19). 

Pin Signal 

1 SMPTE Running output (Contact 1) 

2 SMPTE Running output (Contact 2) 

3 Fault output  (Contact 1) 

4 Fault output  (Contact 2) 

5 Ready output (Contact 1) 

6 Ready output (Contact 2) 

7 SMPTE Start input (+) 

8 SMPTE Start input (-) 

9 SMPTE Pause input  (+) 

10 SMPTE Pause input (-) 

11 SMPTE Stop input (+) 

12 SMPTE Stop input (-) 

13 Mute input (+) 

14 Mute input (-) 

15 VCC (+5VDC) supplied by Binloop power supply 

16 GND 

17 GND 

18 GND 

19 GND 

20 Play and Loop clip 1 of group 1. 

21 Play and Loop clip 2 of group 2. 

22 Play and Loop clip 3 of group 3. 

23 Play and Loop clip 4 of group 4. 

24 Play and Loop clip 5 of group 5. 

25 Play and Loop clip 6 of group 6 

26 Play and Loop clip 7 of group 7. 

27 Play and Loop clip 8 of group 8. 

28 Reset SMPTE. 

29 Idle SMPTE (refresh) 

30 Reserved (leave unconnected) 

31 Reserved (leave unconnected) 

32 Reserved (leave unconnected) 

33 High = SMPTE Locked, Low = not locked 

34 High = Video Sync locked, Low = no sync detected 

35-37 (not used) 

 



 

Alcorn McBride A/V Binloop Uncompressed User’s Manual Page 75 

Control Card Jumpers 

 The following Controller cards have jumpers located on them that can 
be used to change certain settings on the card itself.  

 

DBAP5 Controller Revision B 

JP1 is the video sync type jumper:  

POS 1-2 = Blackburst   

POS 2-3 = Composite Sync 

W1 is the 75 ohm termination jumper for V-sync, and should be 
installed. 

JP2, JP3, and JP4 are used to switch the Show Control port between 
RS232 and RS422   

POS 1-2 = RS232   

POS 2-3 = RS422 
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Media Files 

The reproducer cards in an A/V Binloop Uncompressed play 
back sequences of images, one for each frame, contained in 
folders on the SSD.  This section provides detailed information 
on those requirements so that you can successfully create and 
load content into the A/V Binloop Uncompressed. 

 

File Types  

The A/V Binloop Uncompressed stores clips as a sequence of 
still image files in a directory.  These images can be either in the 
Targa format, or in Alcorn McBride’s AMT file format.  Use the 
free file conversion function of Alcorn McBride’s MediaFlow 
software to convert image sequences to the appropriate file 
format. 
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File Naming  

Clip Naming 

Each clip on the A/V Binloop Uncompressed is stored in its own 
directory on the SSD and referenced by a clip number.  That clip 
number is taken from the last characters of the directory name. 

For instance, an SSD loaded with three clips could have the 
following directories on the SSD:  

MorningShow00001 
AfternoonShow00002 
EveningShow00003 

Each of these directories contains hundreds or thousands of 
image files which make up your video clip.  The clip number at 
the end of the directory name should be between 0 and 1023.  

The clip number should not be more than 5 digits, but does not 
have to be padded with any particular number of zeroes, 
MyClip01 and MyClip00001 are equivalent. 

The clip number should be unique.  Do not have directories with 
the same clip number, such as MyClip01 and MyClip00001 on 
the same SSD. 

Valid Clip Directory Names:  
Vid00001 
MyClip2 
OtherClip0003 

Invalid Clip Directory Names:  
001 (clip number should have prefix) 
MyClip0000002 (clip number has too many digits) 
SundayVideo (no clip number in name) 

The following screenshots shows an example of an SSD with the 
three example clips loaded: 
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Image Sequence Naming 

Within each directory is a sequence of still image files consisting 
of each frame of the clip.  For instance, the above 
EveningShow00003 directory could contain the following files, 
each a frame from the clip: 

EveningShow 00000.tga 
EveningShow 00001.tga 
… 
EveningShow 01799.tga 
 

In this example, clip #3 is 1800 frames long.  If a 59.94fps 
framerate is selected, this means the playback time of that clip is 
about 30 seconds. 

Frame file numbers within a directory should start at 0 and be 
consecutive.  

The following screenshot shows an example of the first few files 
in a clip directory: 

 

 
 

Encoding Content Via Media Flow 

Getting MediaFlow 

MediaFlow is software used to encode source material and 
transfer it to your Alcorn McBride A/V Binloop Uncompressed.  It 
can take in a wide variety of image sequence and video file 
formats, and convert them to the formats used by the A/V 
Binloop Uncompressed.   

The Software can be downloaded for free from the Alcorn 
McBride website at www.alcorn.com/support/software 
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Settings Page 

After launching MediaFlow, the settings dialog will appear. 
Choose the A/V Binloop Uncompressed, and click next. 

 

Note: If you’ve already manually transferred content to your 
drives, and only wish to index the drives, click the “Index Drives” 
button on this screen. 

 

Adding input files and output destinations 

The Input dialog can be accessed by clicking the Next Step: 
Input Files button on the settings page. 
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The Add Video File button allows you to add a standard video 
file for MediaFlow to encode.  

 

The Add Image Sequence button allows you to select a folder 
which includes Image Sequences.  

 

Clicking on Remove Source will remove the selected source 
from MediaFlow. 

Notice that MediaFlow will automatically set the source 
framerate, resolution, and output format once a source is added. 

 

The Add Destination button adds a destination (drive or local 
folder) where the output files of MediaFlow will be placed.  If you 
are connecting multiple Binloop SSD’s directly to your computer, 
they will be detected and the clip will be automatically split 
between the drives.  If you are converted 4K content but only 
have a single drive connected, you can still add the 4 
destinations, and you will be prompted to connect the remaining 
3 drives, one after another, during the conversion process. 
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Clicking on Remove Destination will remove the destination 
from the selected source. 

 

Clicking on Select a Drive opens a window to choose an SSD 
for MediaFlow to encode to (previously formatted SSD will be 
shown to select the individual drive you want to convert).  

 

 

Click Start Batch to begin encoding the content. As part of this process, 
MediaFlow will automatically index your SSDs. 
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Installation Guidelines 

 

A Word on Temperature 

The Binloop requires free air ventilation.  All models are 
designed to operate between temperatures of 32 to 100 degrees 
F and 0 to 99% non-condensing relative humidity.  Like all other 
electrical equipment, this means that an air-conditioned 
equipment room is the optimal environment.  Temperatures can 
easily exceed the high limit if the Binloop is mounted without 
proper ventilation or mounted directly above or below a piece of 
equipment that normally runs hot (i.e. power amplifier).  
Remember, high temperature is the enemy of all electronic 
equipment.  For adequate ventilation, please leave an empty 1U 
rack space on the top and bottom of the A/V Binloop 
Uncompressed. 

 
 

SSD Media Reliability 

The SSD drives supplied with your A/V Binloop Uncompressed 
are data-center class drives designed for 24/7 operation and 
sustained performance.  The manufacturer’s MTBF (Mean-Time 
Between Failure) is 2,000,000 hours.   

When failures do occur they normally occur during the first few 
hours of use.  Often this is called “infant mortality.”  Even this 
failure mode is extremely rare, however.   

Nonetheless, it is always prudent to properly backup all of the 
video data contained in your Binloop.  This can easily be done by 
simply copying the data to a PC hard drive or by making CDR or 
Data-DVD/R backups. 

Like any other computer system, your sound and video files for 
the Binloop should be treated as critical data.  Successful 
operation of your installation depends on this data. 

Unlike consumer-grade SSD’s, these data-center class SSD’s 
run special firmware designed for the demanding 24/7/365 
environment that your Binloop is designed for.  For this reason, 
please only use SSD’s supplied by Alcorn McBride, or you will 
see performance issues. 
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Removing a Card from the Cage 

WARNING:  The following information should only be used when 
a card (Controller or Video Reproducer) has failed and must be 
returned to Alcorn McBride Inc.  Removing a card carelessly 
could result in further damage, which would not be covered 
under your warranty.  PLEASE BE EXTREMELY CAREFUL!!! 

 

1. Disconnect power from the unit. 

2. Remove the magnetic front panel from the unit. 

3. If removing a reproducer card, proceed to step 5.  If 
removing the controller card, use a Phillips head 
screwdriver to remove four screws holding on the left 
bracket holding the display and encoder knob.  These 
screws also hold on the powerful magnets that hold the 
front cover – after removal don’t let the screws/magnets 
slam together, they could break!  Also, be careful of the 
cables connecting the display and encoder.  Observe the 
polarity of these cable connections and be sure to 
reconnect in the same way if either becomes 
disconnected. 

4. Inside the unit should be: 

• The Power Supply (a silver box on the left side) 

• The Controller Card (the card on the left with four 
buttons on the lower end and an array of ten LEDs 
on the top. 

• Various Video Reproducers - Cards with one button 
on the top, an LED right underneath, and a slot for 
an SSD. 

5. Verify the stability of each card (Controller and Video 
Reproducers) to make sure that it has not simply 
become disconnected: 

• GENTLY push on the card to make sure that is not 
off of the tracks in the slot.  If it is stable, proceed to 
step 7. 

6. If the card is not stable: 

• GENTLY pull the card out of the slot. 

• Carefully align the card in between the guides.  The 
solder side of the circuit board should be facing 
away from the power supply on the left. 

• GENTLY push the card toward the back end of the 
unit until you feel the pins lock into place.  DO NOT 
FORCE THE CARD IN! 

7. To Remove the Card: 

• Find the card that needs to be replaced. 
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• GENTLY pull the card toward you.  At first you will 
feel some resistance as you pull the card from its 
connectors in the back.  After the card has been 
detached, it will slide easily. 

8. Place the card in a Static Shielding bag to protect the 
board from static discharge. 

9. Place the card-in-the-bag on a stable surface. 

10. If you removed the encoder/display bracket, replace it 
and tighten the screws.  Do not overtighten these 
screws, as it could break the magnets! 

11. Carefully place the magnetic cover back onto the unit.  
Make sure that it is facing the right direction (The Alcorn 
McBride logo should be right-side up. 

12. Pack the card-in-the-bag in a box, padded to protect 
against damage. 

Please be sure to obtain an RMA number from your distributor (if 
outside USA) or from Alcorn McBride before returning product. 
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Specifications 

 

Physical 

Power: 100 - 240VAC, 6-3A Max. 60-50 Hz. 

Size and Weight: 19” W x 5.25” H x 11.50” D, 19 lbs. 

Environment: 0° C (32°F) to 38° C (100° F) 

0-90% Relative Humidity 

 

Control Information 

Push Button Controls: Start/Stop or Mute (1 per Reproducer) 

SMPTE Start, Pause, Stop, Mute All 

LED Indicators: Power, Fault, Lock, Gen, Ready, Run, Pause, 
Stop, Mute 

OLED Display: 2 x 16 Characters 

Parallel Inputs: Loop, Stop (for 8 groups) 

Start SMPTE, Pause SMPTE, Stop, Opto-
Isolated 

Parallel Outputs: Ready, Running, Fault, dry contact relay 
outputs 

Show Control Serial: RS-232C – Settings vary by protocol 

Programmer Port Serial: RS-232C at 9600 baud (9th-bit parity) 

Video 

Formats: Targa or AMT Image Sequences 

Resolution: 1200p (1920x1200), 2Kp (2048x1080),1080p, 
720p 

Frame Rates (fps): 60, 59.94, 50, 48, 47.952, 30, 29.97, 25, 24, 
23.976 

Digital Output: HDMI, 3G/HD-SDI (SMPTE-292M/SMPTE-
424M) 
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SMPTE 

Frame Rates: 23.976, 24, 25, 29.97, 30-drop, or 30 

Trigger Skew: 23 µSec max 

Lock Range: +/- 20% 

Timing Stability: 7 ppm 

Dropout Tolerance: Configurable (None, Infinite, or 1-8 seconds) 

Input: Transformer Isolated 

Input Impedance: 600Ω balanced 

Output: Balanced 2-10 VPP selectable 0dBV to +4dBV 
selectable 

Output Impedance: 10Ω maximum 

Load Impedance: 10KΩ 

 



 

Alcorn McBride A/V Binloop Uncompressed User’s Manual Page 88 

 

Application Notes 

 

Note 1: Automatically Play on Power-Up 

Many times, all you may want the Binloop to do is to play and 
loop a video clip when it is powers up. This can be accomplished 
using the Binloop’s built-in SMPTE generator, and the Timecode 
control interface.  This application note will lead you through the 
process of configuring the unit to use these features to perform 
this type of function. 

Preparation 

If you do not already have a SSD loaded with a video clip, then 
follow the procedures found in the Playing A Test Video section 
before going any further. This section will take you through the 
steps needed to format an SSD and load it with a test video. 

This application note also requires that you have the Binloop 
Configuration software installed on a PC, and that the PC is 
connected to the Binloop using Ethernet or RS-232.  If you do 
not have this software or you need guidance with connecting 
your PC to the Binloop, refer to the Binloop Configuration 
Software section before continuing with this example. 

Connecting to the Binloop 

To get started, launch the Binloop software and verify that you 
have established a connection with the PC to the Binloop.  An 
easy way to do this is to upload the configuration from the 
Binloop to your PC.  To do this, click on File→New Upload from 
Binloop…  Unless you have already established a connection 
with the Binloop, a screen will appear prompting you to select the 
communication method.  Select the appropriate method, and the 
click OK to begin uploading the Binloop configuration to your PC. 

Once the upload is complete, a window will appear within the 
Binloop application.  This window is called the Trigger List, and 
contains a list of all timecode triggers that were stored in the 
Binloop.  If there were no triggers stored in the Binloop, this list 
will be empty.  If you have reached this point without receiving 
any communication errors, you have successfully established a 
connection with the Binloop. 
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Modifying the Binloop Configuration 

There are a few important things that need to happen before the 
Binloop can automatically play video on power-up.  First, we 
need to configure the Binloop’s SMPTE timecode interface to 
automatically generate timecode when the unit powers on.  Next, 
we have to create a timecode trigger that will instruct the Binloop 
channels (Reproducers) to begin playing a video.   

The idea is that the SMPTE clock will begin running on power 
up.  When this clock reaches a certain value, a trigger will 
instruct the Binloop reproducers to play a video.  When the video 
is finished, the SMPTE clock will loop back to its starting value 
and cause this process to repeat indefinitely. 

Unit Configuration 

Let’s begin by configuring some of the basic Binloop settings.  In 
the Binloop software, navigate to the Unit Configuration screen.  
To do this, select Binloop→Settings→Unit... from the 

application menu or by click on the  icon in the menu bar.  

 

 

For the sake of this example, the majority of these settings are 
not important.  Just make sure that the number of reproducer 
slots is configured for 8, and that the Standard controller card is 
selected.  Once you have verified these settings, click OK to exit 
this screen. 
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SMPTE Configuration 

Next, we will setup the SMPTE interface in the SMPTE 
Configuration screen.  You can access this screen by selecting 

Binloop→SMPTE→Configuration… or by clicking on the  
icon.   

 

 

Even though there is only one trigger at the start, we’ll have the 
SMPTE clock run synchronous to the video.  Select 29.97 as the 
frame rate and enable the Genlock To Video option.  Make sure 
“Start Automatically on Power Up” is checked.  Uncheck 
“Loop SMPTE at End Time” to make sure that the trigger is 
only executed once. 

Now, the only thing left to configure is the range of time that the 
SMPTE interface will generate.  First, set the Preroll Time to 
00:59:55.00 and the Start Time to 01:00:00.00.  Because we 
only have one trigger, to loop continuously, SMPTE End Time is 
not relevant.
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Trigger List 

Now we have the important configuration screens set up, we 
need to add a Loop trigger to the trigger list.  This trigger will 
command the reproducers to play a video at the time we specify. 

 

To create a new trigger, click the Add button at the top left of the trigger 
list window. The following window will appear. 

 

 

First, we need to enter the SMPTE time when we want this 
trigger to occur.  Enter 01:00:00.00 in the Time box.  Select Play 
as the Action, and make sure the Loop option is checked.  In 
the Location box, select All Reproducers.  Next, verify that the 
Segment is set to 1 (this assumes that you have named your 
clip as clip #1, as instructed in the Playing a Test Video 
section).  Click on OK to add the trigger to the trigger list. 
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Downloading the New Configuration 

We’ve now created a configuration that will cause the Binloop to 
play and loop video when it powers up.  All we have to do is 
download that configuration to the Binloop so that it will take 

effect.  To initiate the download, click on the  icon or select 
Binloop→Download to Binloop…  A window will prompt you to 
make sure that you want to download the new configuration and 
overwrite the configuration currently in the Binloop.  When you 
proceed, the following progress window will appear to show you 
the real-time progress of the download. 

 

 

 

The configuration we just created is now stored in the Binloop.  
To verify that it works, turn the Binloop off and then back on 
again.  After it finished initializing, the SMPTE clock will start 
running.  When the clock reaches 01:00:02.00, every reproducer 
in the Binloop with a video #1 will start playing video and 
continue to loop this video. 
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Note 2: Controlling the Binloop with an Alcorn McBride Show 
Controller 

While the Binloop has some very powerful features that allow it to 
operate as a stand-alone device in many circumstances, there are 
inevitably applications where an external control system is required. An 
installation may have other elements besides video such as lighting, 
audio, special effects, interactive interfaces, etc.  In addition to making 
A/V products like the Binloop, Alcorn McBride also specializes in making 
Show Control systems to easily manage applications like these. 

This goal of this application note is to show how easy it is to integrate 
one of our show control products with the Binloop for simple remote 
control.  This particular example will use an Alcorn McBride V4Pro to 
start video playback in the Binloop from a button press.  Keep in mind 
that, although we’re using a V4Pro in this example, all of our controllers 
would be programmed using the exact same method. 

 

Preparation 

This application note requires that you have video clips loaded onto the 
Binloop.  If this is not the case, then follow the procedures found in the 
Playing A Test Video section before going any further. This section will 
take you through the steps needed to format the SSD and load it with a 
test clip. 

This application note also requires that you have the Alcorn McBride 
WinScript Live software installed on a Windows PC.  This software is 
always available as a free download from our website at 
http://www.alcorn.com/.  Your PC must be connected to the Show 
Controller’s Programmer port using an RS-232 serial cable or connected 
via Ethernet. 

Last but not least, the V4Pro and the Binloop must be connected via RS-
232 or Ethernet.  In this example, we will be controlling the Binloop from 
RS-232 Port 1 of the V4Pro.  This means that a Null-model RS-232 cable 
must be connected between Port 1 of the V4Pro to the Show Control 
port of the Binloop. 

 

 

http://www.alcorn.com/
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Configuring the Binloop 

Before the V4Pro can properly control the Binloop, some steps must first 
be taken to prepare the Binloop.  We must make sure that the Binloop is 
not doing anything that will interfere with the commands from the show 
control system.  For example, if you followed the steps in the previous 
application note, the Binloop would currently be configured to trigger 
itself to play periodically.  Connecting a show controller will not prevent 
this, so you must take steps to prevent any undesired behavior.  This 
could be accomplished by deleting triggers from the Trigger List, 
configuring the SMPTE clock to be idle, or both.  If you need assistance 
doing these things, you can use the previous application note as a guide 
on changing the Binloop’s configuration. 

 

Programming the Show Controller 

Alcorn McBride Show Controllers are designed to be programmed 
initially by a PC, and then operate independently of the PC once the 
programming is complete.  We call this program a ‘script’, and it is 
created and transferred using the WinScript Live application mentioned 
earlier in the application note.  

To get started on writing a show control script, launch the WinScript Live 
software.  Select New from the startup screen, or click on File→New. 
The following screen will appear: 

 

 

 

Select the show controller you wish to use, and then click OK.  In this 
example we will be using V4Pro. After that, a new blank script will be 
created that looks like this: 
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Before modifying the new script, click on File→Save to give it a 
descriptive name and store a copy of the script on your PC.  For this 
example, we will save our script as “V4Pro-AVblUC”. 

Port Configuration 

Next, we need to tell WinScript Live that an A/V Binloop Uncompressed 
is connected to Port 1 of the show controller.  Click on 
Resources→Devices to open up the devices form.   

Follow these steps to add the A/V Binloop Uncompressed as a device: 

1. Double click the first box under the Double Click on first box 
under the Name column and enter "BinloopUC" as the name of 
the first device. This name is arbitrary and you can use anything 
you want, just try to make it something obvious and descriptive. 
For example, if you have more than one A/V Binloop 
Uncompressed in your show you might want to name them 
BinloopUC_1 and BinloopUC _2, or BinloopUC_Preshow and 
BinloopUC_Mainshow. Do not use spaces in naming system 
resources. 

2. Move to the Device Type column and double click the box. A 
series of dialog boxes will open asking for the following 
information… 

3. The first dialog form asks for the Manufacturer, Model, and 
Version of the equipment to be connected to the show 
controller. Here we choose “Alcorn McBride, Inc.” as the 
Manufacturer and “A/V Binloop Uncompressed” as the 
Model. The Version refers to the current version of the Product 
File, which is the file used by Winscript Live to tell it how to 
communicate with the Device. Here is comes up as Version 1.0. 

 

4. Click Next to advance to the next dialog to set up the connection 
type. The default is Ethernet, and if selected, the user will be 
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prompted for the Ethernet port letter, protocol format,etc. We’ll 
use serial port, with port1, ASCII protocol, and the defaults for 
the communicant fields. These being a baud rate of 9600, a 
parity of n, 8 bits, 1 stop bits, and port mode of rs232. 

 

5. Click Next to advance to the next dialog, where you can assign 
Device Variables. These are variables that can be controlled by 
the Device itself and are useful for error detection and unsolicited 
device status indications. We won’t be using them in this 
example, so just click Next again to advance to the next dialog. 

6. The last dialog allows you to include some comments about the 
Device. Here is where you could describe where the device is 
located, or what it is used for (i.e. “Preshow main video”, or 
something like that). Click Finish to and you will have added the 
A/V Binloop Uncompressed to your list of Devices… 

 

 

Creating a Sequence 

Next, let’s add a new sequence called PlayClip. Click on the Sequences 
tab, then double-click on the empty cell just below the cell that contains 
Default. Type in the name “PlayClip”.  
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Creating the Input Trigger 

We have now created a sequence that we will eventually program to 
start playing a file in the A/V Binloop Uncompressed.  Before we get to 
that part, let’s first configure this sequence to be triggered by pressing 
Button #1 of the V4Pro.  To do this, right-click on the PlayClip sequence 
and select Add Trigger→Start.  This will open a window that will allow 
you to specify a trigger to start the PlayClip sequence.  Under Discrete 
IO select button1 as the input name, and then click the OK button. 
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Your script should look like this: 

 

 

 

Now, the PlayClip sequence will be triggered when Button #1 on the 
front of the controller is pushed.  

 

Editing the PlayFile Sequence 

At this point, the PlayClip sequence is empty, so nothing will happen 
when it is activated.  That means that the next step is to add events in 
the PlayClip sequence so that it commands the Binloop to play a file.   

To access the event list for the PlayClip sequence, right-click on 
PlayClip and select View Events.  You can also double-click the 
sequence number on the left-hand side (i.e. 0002) to access the event 
list. 

Most events in WinScript Live require additional information, or data 
parameters, to work. For example, the Play event needs to know which 
Binloop to talk to (there might be more than one!), which reproducer to 
control, and what file to play. On the next page, there is an outline as to 
what to put into each field. However, to determine what information to 
enter in each column, you can always right-click and select Event 
Wizard for guidance. 

 

 

Here’s an explanation of the event fields, as well as how you should fill 
them out for this application. 

Time – This field specifies when to execute the event in relation to the 
when the sequence is started.  We want our Play event to happen 
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immediately after the sequence is started, so leave the time value as 
00:00:00.00. 

Event – This is the action that is to be taken at the specified time. In this 
case, we are using the Binloop Sync Play event which instructs one or 
more channels of the Binloop to synchronously play a file. 

Data1 – For the Sync Play event, this data parameter needs to specify 
the name of the port connected to the Binloop we want to receive the 
command.  We are using Port 1, which we named BinloopUC earlier in 
this application note.  Enter BinloopUC in this column. 

Data2 – The Sync Play event uses this parameter to identify which card 
(or cards) to command to play.  This event allows you to command a 
single reproducer (R1-R8), a 4K channel (F1, F2), a group of 
reproducers (G1-G13), or all reproducers (All).  Enter F1 in this column 
to specify 4K channel #1. 

Data3 – The Sync Play event uses this field for the video clip number.  
Reproducers can have multiple clips stored on their SSD, so it’s 
important to specify which clip to play.  Enter the number 1 in this field. 

We have now created an event that will command the Binloop to 
synchronously play file #1 on 4K Channel #1 as soon as the PlayFile 
sequence is started.  You can now close the PlayFile Event list, and 
return to viewing the Sequence list. 

 

Downloading the Script to the Show Controller 

Our script is now finished and ready to compile and download.  Start by 

clicking on the  icon in the menu bar, or by selecting 
Control→Download Script.  The script is then compiled and checked 
for errors.  If no errors are found the screen will look like this. 
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After pressing OK, the following window will appear showing the 
progress of the transfer of the script.   

 

 

 

When the script is successfully transferred, the window will close, 
allowing you to move on to the next step. 

 

 

Testing the Show Control Script 

At this point, the script is now running on the show controller.  You can 
now press Button #1 on the front of the show controller to play video #1 
on reproducer #1 of the Binloop.  Immediately after you press the button, 
you will see the serial LED 1 blink to indicate that the controller is 
sending a serial message on RS-232 Port 1.  You will then see the green 
status LED of Reproducers 1-4 illuminate green to indicate that it is 
playing a video. 

Now that you have the basics, you can easily modify this script to do 
other things more suited for your application.  Perhaps you want to play 
different files based on which button is pressed?  Maybe you want to 
trigger playback from a motion sensor wired into the controller?  Having 
a Show Controller in your system provides all kinds of possibilities. 
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Note 3: Connecting to the Binloop using Ethernet 

Ethernet is a very common communication interface used to 
connect devices together.  Using the Binloop’s Ethernet 
interface, you can download configurations and even control the 
Binloop across an Ethernet network. 

Ethernet is a very broad standard with many complexities that go 
way beyond the scope of this manual.  The intention of this 
application note is to simply demonstrate how to connect a 
Windows PC directly to the Binloop using Ethernet. 

Preparation 

This application note also requires that you have the Binloop 
Configuration software installed on a PC, and that the PC is 
connected to the Binloop via Ethernet.  If you do not have this 
software, refer to the Binloop Configuration Software section 
before continuing with this example. 

As for the Ethernet connection itself, there are two ways to do 
this.  The most common way is to use standard Ethernet patch 
cables and a network switch.  When you connect the PC and the 
Binloop to the numbered ports of the switch, the status LED’s of 
the switch should indicate a connection. 

 

 

 

 

   

 

 

 

 

 

Another way to connect you PC to the Binloop over Ethernet is using an 
Ethernet crossover cable, like the red one included with the Binloop 
packaging.  This cable allows you to connect the PC directly to the Binloop 
without the need for a switch or hub.  
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Changing the Network Settings of your PC 

In order for a PC to communicate to a Binloop over an IP-based 
Ethernet network, the PC and the Binloop must be on the same 
Subnet.  By default, the Binloop uses the 192.168.0.xxx subnet.  
This will most likely require you to change the network settings of 
your PC before you are able to communicate with a Binloop that 
is using default network settings.  The following steps will guide 
you through checking and setting a Windows XP-based PC 
correctly.  Other computer operating systems may differ in 
method and appearance, but the concept is still the same. 

1. Open the Windows Control Panel and open Network 
Connections.  Your PC’s Ethernet connection will 
appear in this list, and is usually named Local Area 
Connection.  Keep in mind that you may have several 
network connections, so it’s important that you select the 
connection that is connected to the Binloop. 

2. Right-click on this connection and select Properties.  
Click on the Internet Protocol (TCP/IP) item them click 
the Properties button. 

3. When the TCP/IP properties window opens, write down 
all of your current settings before making any changes.  
When you are done communicating with the Binloop, 
you will need to return to this screen and restore your 
previous settings. 

4. Click the option Use the following IP address.  

5. Enter 192.168.0.100 into the IP address box  

6. Enter 255.255.255.0 in the Subnet mask box 

7. Enter 192.169.0.1 as the Default gateway 

8. Click OK to apply the new IP Address to your PC. 

9. Click OK once again to exit the connection properties 
screen. 
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Configuring the Network Settings of the Binloop 

This application note requires your Binloop is configured for the 
factory default network settings, which are as follows: 

 

IP Address 192.168.0.254 

Subnet Mask 255.255.255.0 

Gateway 192.168.0.1 

 

If you believe that these settings may have been altered, you should 
verify them using the front-panel menu wheel interface of the Binloop. 
Browse to the Network Setup screen and make sure that all of the 
settings match these values. 
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Connecting over Ethernet with the Binloop Software 

At this point, your PC is now physically connected to the Binloop 
through Ethernet.  We’ve also made sure that both the Binloop 
and your PC have network configurations that are compatible, 
and capable of communicating with one another.  The next step 
is to actually use this interface to communicate with and control 
the Binloop.   

Begin by launching the Binloop Software.  When the program is 
loaded, open the Connection Settings screen by clicking on the 

 icon or selecting Binloop→Settings→Connection… 

 

 

 

Select Ethernet as the communication method and verify the 
default address of 192.168.0.254 is in the Binloop IP Address 
box.  When you select Ethernet, the following message may 
appear. 

 

 

 

If it does, select Yes and then click OK to exit the Connection 
Settings screen. 

We can now verify the Ethernet connection by uploading the 
configuration from the Binloop to your PC. To do this, click on the 

 icon or select Binloop→Upload From Binloop…  
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When this screen appears, click on the Detect button.  If the 
Ethernet connection is working, the version box should fill with 
the current firmware version of the Binloop’s controller card.   

If you wish, you may click Upload to transfer the Binloop’s 
configuration to your PC over the Ethernet connection.  You can 
also use all of the features of the Binloop software to change 
configuration settings, and control the Binloop over Ethernet. 
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Note 4: Synchronizing Multiple Binloops 

Syncing Multiple Binloops with a Show Controller   

The easiest way to sync multiple Binloops is using an external show controller. 

To synchronize multiple Binloops, you must first have an external video sync source such as a 
Horita BSG-50 connected to each Binloop and your show controller.  Using a frame-accurate 
show controller, like the Alcorn McBride V16X, you can create a script to start all of your Binloops 
in perfect sync. 

A Brief tutorial using WinScript Live is shown below: 

1. Create a new sequence to trigger the multiple Binloops. 

2. Use the SPlay event to trigger synchronous playback with multiple Binloops. The All 
parameter is used in Param1 to trigger playback in every video reproducer on the 
Binloop. Param2 tells the Binloop which media file to play. 

 

1. Click the  button in the events window. 

2. Navigate to the Behavior tab and uncheck "Wait For Device Responses." 
This allows the show controller to instantly send out the command to every 
device, rather than waiting to send the command for a device until it gets a 
response from the previous device. 
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Syncing Multiple Binloops with a SMPTE Trigger  

If you are triggering via SMPTE, you'll still need a V-Sync source.  

If you are using a Binloop as a SMPTE master, you must perform the following steps: 

Select one Binloop to be the master and configure it as described below.  The SMPTE output of 
the master can then be connected to the SMPTE input of the first slave.  The SMPTE output of 
the first slave can be connected to the SMPTE input of the second slave and so on.  Each slave 
must be configured as described below.  All of the Binloops are now synchronized to start on the 
same frame due to the SMPTE source and to stay synchronized due to the V-Sync source. 
 
Master Binloop Config 
Using the Binloop Config software, configure the SMPTE settings to Generate SMPTE and check 
the "Start Automatically on Power Up" checkbox, or provide some external means of Enabling 
SMPTE on demand to master (e.g. push button, Serial Command, or Ethernet command). 

 

Slave Binloop Config   
Using the Binloop Config software, configure the SMPTE settings to Read SMPTE. 

  

Create your trigger table as needed for the attraction by following the "TIMECODE TRIGGER 
List" in the manual. Set Slave Binloop trigger times to one frame earlier than the master. 

 

If you are using a third party external SMPTE generator, you must perform the following 
steps: 

Put all Binloops in READ MODE, then build your trigger table with synchronized Trigger times, 
and ensure the "Start Automatically On Power Up" checkbox is checked. 
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Note 5: Chasing Timecode And “Scrubbing” 

On a typical setup all units must receive the same Sync Signal via a Sync Generator.  In order to 
keep sync up-to-the-very-frame the entire system must be in the same frame rate. When an 
external SMPTE clock generator is used our controller must be set to accept the incoming LTC 
and this is done by allowing the controller to be in Read mode.  Imagine that the Audio Engineer 
(represented in Fig. 1 as our external SMPTE clock generator) wants to mix the show audio at the 
same seating area as the guest. The Engineer will provide you with a SMPTE signal. Every time 
the engineer goes forward in time or back in time to listen to his or her progress all the devices 
should move together at the same time.   If the engineer drags the cursor over a segment on the 
timeline this is defined as Scrubbing. 

 

Fig.1 

Setting up a Script for success: 

Always make sure our controller can read a SMPTE signal and lock clock via V-Sync.  All these 
settings can be adjusted under the Configuration tab and by picking Timecode. 
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Next add 4 AV Binloop Uncompressed units into the script. 

 

Three (3) basic sequences now need to be created: 

Sequence one (1) is to Arm the Timeline when Button 1 goes on, sequence two (2) is the Video 
Timeline and sequence three (3) is to disarm the timeline when button 2 goes on. 

 

Sequence One: Arm Timeline 

 

Sequence Three: Disarm Timeline 

 

Sequence Two: Seq. Video Timeline 

Create a new sequence and set the sequence type to SMPTE/EBU and display type to timeline 
view (this is a key point that cannot be missed).  The SMPTE/EBU must be selected when the 
controller is generating his own or reading SMPTE. 
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Once finished, add the media files into the timeline.  In this case we are using four AV 
Binloop Uncompressed where each unit will be playing a video file named “My Video File 
01”. 

 

Align each video so all AV Binloop Uncompressed units start at the same time. Right click 
on the first video file and choose Edit Event. For this example, here we are using a SPlay 
Event to all the Repro2KU cards that belong to 4KG1. 
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Followed by the settings on the next window. 

 

Once finished save the script file and send it into the controller. After rebooting, click on Connect 
and press the button #1 to trigger the Arm Timeline sequence to run. 

 

If you want to see the cursor moving over the Timeline View simply double click Seq. Video 
Timeline to scrub to a specific time in the timeline then enter the new time on your SMPTE 
generator and the cursor will move to that point. 



 

Alcorn McBride A/V Binloop Uncompressed User’s Manual Page 112 

Appendix A - Troubleshooting 
Guides 

 

Card Cage Troubleshooting Guide 

Symptom Cause(s) Solution(s) 

1) No Front Panel display 
or LEDs 

a) No Power 

b) Bad Power Supply 

a) Check Power connections 

b) Cycle Power 

2) One or more of the 
reproducers not responding 
to test button press. 

a) Incompatible Video File 

b) Faulty Button 

c) Faulty Reproducer 

d) Faulty Controller 

 

a) Press Reproducer Test Button 
to see if reproducer responds. 

b) Press Mute Button and make 
sure Reproducer LED’s illuminate 
RED. (This verifies 
communication) 

c) Cycle Power 
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Appendix B - Updating Firmware 

The various components of the Binloop are all capable of 
accepting firmware updates.  The following guides will instruct 
you on how to update the firmware of each component. 

Reproducer Card Firmware 

The Repro2KU Uncompressed Video Reproducers within the 
Binloop can be updated by copying a firmware update file to a 
SSD and inserting the drive into the Reproducer’s SSD slot.  
These step-by-step instructions will walk you through this 
process: 

1. Download the latest firmware for the Repro2KU from: 

  http://www.alcorn.com/support/firmware.html  

2. Extract the zipped firmware update file to your PC. 

3. Power down the Binloop, and remove the SSD from the 
reproducer you wish to update. 

4. Copy the OS.NEW file from the downloaded update to 
the SSD using a SATA dock or USB to SATA cable. 

5. Re-insert the SSD into the Reproducer. 

6. Power on the Binloop. 

7. The reproducer’s status LED will turn WHITE to indicate 
that it is updating the firmware. 

8. Wait for LED to turn off, indicating that the firmware 
update is complete. 

9. When you reach this point, you’re done. The OS.NEW 
file will be renamed to OS.SAV to flag the successful 
operation.  

10. Use the Version command to verify that the 
Reproducer’s firmware has actually been updated to 
match the version on the website. 

11. Repeat this process for each reproducer. 

NOTE: If multiple updates are to be performed, you can rename 
OS.NEW to FACTORY.NEW. This causes the update to occur without 
the file name changing to OS.SAV after the update is complete.  This 
allows you to update an entire cage of reproducer cards with a single 
SSD containing the FACTORY.NEW file. 
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Controller Card Firmware Update 

The DBAP5 Controller Card used in the Binloop must be 
updated over an RS-232 serial connection.  This will require a 
Windows PC with an RS-232 port (or a USB→RS-232 serial 
adapter).  This PC should also have the latest version of the 
Binloop Config software installed.   

Once these requirements are met, please follow the following 
instructions to update the DBAP5 Controller Card: 

 

1. Download the latest firmware from: 

http://www.alcorn.com/support/firmware.html  

2. Extract the zipped firmware update file to your PC. 

3. Power on the Binloop. 

4. Connect a straight-through RS-232 cable between a PC 
and the Binloop’s Programmer serial port on the back. 

5. Launch the Binloop Config software. 

6. From the Binloop software menu, select Help→Update 
Firmware… 

7. Choose the COM port for the PC serial port that is 
connected to the Binloop. 

8. Click the Connect button and verify that the Binloop 
responds with “Connecting…success!”. 

9. Click the Browse button, and browse to the folder you 
extracted in step #2.  Select the .AMU and click Open. 

10. Click on the Update button, and wait for the “All updates 
finished successfully” message in the log.   

You have now successfully updated the DBAP5 controller card.  
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